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Read Me First

Welcome to Take Control of Troubleshooting Your Mac, version
1.1, published in 2009 by TidBITS Publishing Inc. This book was
written by Joe Kissell and edited by Adam Engst.

Macs are easy to use, but they can experience problems like any
other machine. When something goes wrong with your Mac, use
this book to discover the solution.

Copyright © 2009, Joe Kissell. All rights reserved.

If you have the PDF version of this title, please note that if you
want to share it with a friend, we ask that you do so as you would a
physical book: “lend” it for a quick look, but ask your friend to buy
a new copy to read it more carefully or to keep it for reference. You
can click here to give your friend a discount coupon. Discounted
classroom and Mac user group copies are also available.

UPDATES

We may offer free minor updates to this book. To read any available
new information, click the Check for Updates link on the cover or click
here. On the resulting Web page, you can also sign up to be notified of
major updates via email. If you own only the print version of the book
or have some other version where the Check for Updates link doesn’t
work, contact us at tc-comments@tidbits.com to obtain the PDF.

BASICS

In reading this book, you may get stuck if you don’t know certain
fundamental facts about using your Mac or if you don’t understand
Take Control syntax for things like working with menus or finding
items in the Finder.

Please note the following:

« Menus: Where I describe choosing a command from a menu in
the menu bar, I use a compact description. For example, to create
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a new folder in the Finder, you choose New Folder from the File
menu; I abbreviate this by saying “File > New Folder.”

Finding System Preferences: I sometimes refer to settings in
System Preferences that you may want to adjust. To open System
Preferences, click its icon in the Dock or choose @ > System Prefer-
ences. When the System Preferences window opens, click the icon
of the pane whose settings you want to adjust. I refer to these panes
using an abbreviated notation such as “the Network preference
pane.”

Finding an application’s preferences: I often refer to prefer-
ences in an application that you may want to adjust. Don’t confuse
an application’s preferences with the system-wide settings found in
System Preferences.

To access an application’s preferences, choose Application Name >
Preferences. For example, in the Disk Utility, you would choose
Disk Utility > Preferences. Within some applications, all preference
controls appear in a single window. In others, a bank buttons is
located across the top, or a list of categories along the side. In

those cases, click a button or category to display a pane with a
corresponding range of preferences. Instead of providing detailed
directions each time, I may use an abbreviated notation such as

“go to the General preference pane.”

Path syntax: I occasionally use a path to show the location of a file
or folder in your file system. For example, Mac OS X stores most
utilities, such as Terminal, in the Utilities folder; the path to
Terminal is /Applications/Utilities/Terminal.

The slash at the beginning of the path tells you to start from the
root level of the disk. You’ll also see paths that begin with ~ (tilde),
which is a shortcut for the user’s home directory. For example, if
a person with the user name joe wants to install fonts that only he
can access, he’ll put them in his ~/Library/Fonts folder, which is
just another way of writing /Users/joe/Library/Fonts.

Volumes and partitions: I follow Apple’s terminology in refer-
ring to any disk or partition on a disk as a volume. So if a hard disk
has not been partitioned, it has just one volume. If a disk has been
partitioned, each partition is a volume.



WHAT’S NEW IN THIS VERSION

Version 1.1 of this book was thoroughly updated to reflect the latest
Mac hardware and software, including the correct procedures for
troubleshooting Mac OS X 10.5 Leopard and later (while maintaining
information on working with older versions of Mac OS X). Along with
hundreds of minor changes and additions throughout the manuscript,
this version includes the following major changes:

An updated and expanded list of disk-repair tools and other startup
options, including those applicable to the MacBook Air: Acquire a
Secondary Startup Volume (p. 13) and Start from a Remote Disc

(p. 28)

A new sidebar describing AppleJack: AppleJack (p. 17)

A tip for reading troubleshooting tips when your computer is out of
service: Have a Printed Copy of This Book (p. 24)

Greatly expanded lists of utilities for identifying large files, finding
duplicates, and uninstalling software: Check Free Disk Space (p. 41)

A new sidebar about tools for deleting caches: Cache-Clearing
Utilities (p. 48)

Revised instructions for using Apple Hardware Test: Check Your
RAM (p. 48)



Introduction: Don’t Panic!

You've always heard that Macs are easy to use and less prone to
misadventures than Windows PCs. And that’s true. But they’re still
only machines. And sure enough, one day it happens: you encounter a
serious problem with your Mac and have no idea what to do. Perhaps,
since you'’re reading this book, that day is today.

Repeat after me: Everything is going to be all right. Now take a deep
breath and try again, this time with feeling! Everything is going to

be all right. I want you to believe that. Even if you're feeling panicked
right now because your Mac is doing something wonky and you’re
facing a deadline, I want you to set aside your anxiety for a moment.

Almost every Mac problem you may encounter has a solution. True,
some solutions are more elusive, more time-consuming, or more
expensive, than others, but still: don’t worry. I've been solving prob-
lems with Macs for more than 15 years, and I'm here to tell you that
solutions come more easily when you have a clear head and approach
a problem systematically. That’s what this book helps you to do.

Make yourself a nice cup of tea. (Keep the tea away from your Mac,

by the way—Ilet’s not add to your problems, eh?) Close your eyes and
take a few deep breaths. Then page through this book to learn the most
efficient way to deal with whatever difficulties you may be having.

I've seen more than one Mac troubleshooting book that was upwards
of 600 pages long, and troubleshooting Web sites with thousands of
pages of suggestions. By contrast, this book makes no attempt to be
comprehensive, because merely listing vast numbers of problems and
their accompanying solutions doesn’t help one bit if you have a differ-
ent problem or don’t realize how your problem is like some other one.
What I hope to do, instead, is show you some handy troubleshooting
techniques, provide instructions for solving several common problems,
and then help you figure out what to do when a problem’s cause or
solution isn’t immediately apparent. In other words, I want to teach
you how to be your own technical support person—to do what I do
when something goes wrong with one of my Macs.



Because my focus here is on getting your Mac back into working order,
I intentionally skip over lots of background information and technical
details. So don’t worry if you're unsure exactly why some technique
solves your problem. If you're really interested in the deep background,
some exploration on the Web will probably turn up oodles of detail.

As confident as I am that most Mac problems have straightforward
solutions, I must point out that some problems can’t be solved with

a few mouse clicks or other clever fiddling. If flames are shooting out
of your Mac or the screen is in a thousand pieces, you’ll need more help
than I can provide here. Even simpler hardware problems, such as a
faulty component on your logic board or a busted power cable, may
require a trip to the repair shop. And a few—very few—hardware
problems are either entirely beyond repair or more costly to repair
than is worthwhile. Nevertheless, don’t panic. By the time you finish
this book, you’ll not only know how to solve most problems, you’ll have
the tools and techniques you need to prevent many problems in the
first place, or at least to nip them in the bud. And even if you have a
problem that requires professional help, following the steps in this
book will help you talk to a repairperson more effectively.

If you don’t have any problems right now and are merely reading this
to prepare yourself for future mishaps, good for you! You’ll especially
appreciate the information in the first couple of sections about
preventing problems and preparing for an emergency.

This book is designed to help troubleshoot problems with any version
of Mac OS X from Tiger (10.4) onwards, though many of the tech-
niques also work with older versions. At press time, Mac OS X 10.6
Snow Leopard hadn’t yet been released, but based on my preliminary
testing with beta versions, I expect that everything in this book will
continue to work with it. Click Check for Updates on the cover to check
for any new information or updated versions of this book.

Font of knowledge: One large category of Mac trouble I don’t
cover here is font misbehavior. If you need help troubleshooting

a font-related problem, read Sharon Zardetto’s Take Control of Font
Problems in Leopard.
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Troubleshooting
Quick Start

When your Macintosh has problems, you undoubtedly want to
jump right to the solution. So feel free to skip immediately to Solve
Common Problems (p. 53) and see if your symptom is listed there.
If not, and time permitting, I recommend reading this book in
order, because earlier sections provide useful background infor-
mation for later sections. However, you may also try the steps

in Troubleshoot Novel Problems (p. 76), following the cross-
references as necessary to earlier parts of the book where certain
procedures are described in detail.

Prepare for trouble:

« Even if your Mac is healthy now, take steps to keep it that way. Read
Prevent Problems (p. 10).

« When your Mac starts acting up, you’ll be glad to already have a
toolkit with which you can diagnose and fix it. Learn what you need
to have on hand in Prepare for an Emergency (p. 13).

« Most of the steps you’ll go through when a problem occurs rely
on several common procedures. Learn how to do these tasks before
problems arise so that fixing them will be easier. See Learn Basic
Troubleshooting Procedures (p. 25).

Solve problems:
« If your Mac misbehaves, the problem may be something that many

other people have experienced (and that’s easily repaired). Start
with Solve Common Problems (p. 53).

« Not all problems are common. If you encounter something not
covered in the previous section, learn how to solve it—or find
someone who can—in Troubleshoot Novel Problems (p. 76).

Find more information:

« For further instruction in troubleshooting, check out the electronic
or printed books in Learn More (p. 86).



Prevent Problems

Although this book is mainly about solving problems, not prevent-
ing them, I'm sure you don’t want any issues you’ve fixed to recur.
And a few preventive steps can also make solving problems much,
much easier if and when they do occur.

At the risk of sounding overly promotional, I would like to note
that some of my other books (chiefly Take Control of Mac OS X
Backups and Take Control of Maintaining Your Mac) provide a
great deal of advice that will help you prevent problems, and I
certainly recommend those titles if you need additional help. In
this section, though, I cover three particularly important preven-
tive maintenance tasks.

USE A SURGE PROTECTOR OR UPS

Surge protectors are to a computer what airbags are to a passenger

in a car. No matter how carefully you drive, another driver could cause
a collision—and that airbag could save your life. Likewise, no matter
how clean or reliable the power in your building normally is, a light-
ning strike or power surge could damage components or even wipe
out your computer. It’s unlikely, but it can and does happen.

Considering how inexpensively you can buy a surge protector, using
one is common sense. If you haven’t already done so, spend a few
dollars to prevent hundreds or thousands of dollars worth of damage.
(Still, don’t buy the cheapest surge protector you can find, which
may not offer enough protection. Get one that includes a warranty
covering damage to your computer in the event of a power surge.)

Path of least resistance: A lightning strike can also travel through
phone lines, Ethernet cables, USB cables, or any other conductor. If
your computer has phone or Ethernet cables attached, I recommend
purchasing a surge protector with the necessary jacks to protect your
computer from these additional sources of potential damage; I also
recommend plugging any attached USB devices into a surge protec-
tor or UPS.

10


http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL
http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL
http://www.takecontrolbooks.com/maintaining-mac?pt=INTERNAL

Much better yet, if you can afford it (and they’re not terribly expen-
sive), is an uninterruptible power supply (UPS), which includes not
only significantly better protection from power surges but a battery
that can keep your Mac running for minutes or hours during a power
interruption. Models from APC and Tripp Lite work with Mac OS X’s
Energy Saver preference pane to shut the Mac down automatically in
case of power failure.

For more information and to determine the size of UPS you would
need, visit http://www.apc.com/ or http://www.tripplite.com/.

BACK UP YOUR MAC REGULARLY

Statistically speaking, your odds of having some sort of problem with
your computer that results in a loss of data are high. It may not happen
for years, but if and when it does, the consequences can be devastating.
Crucially for our purposes in this book, some of the troubleshooting
and repair techniques I cover here assume that you have a backup
from which you can restore your data in the event of a serious problem.
So if you’ve never set up a backup plan, don’t delay. Start today!

Backups come in all shapes and sizes. I advocate an approach that
includes a couple of different backup types, having redundant backups,
and storing your media off-site. But if I had to choose just one sort of
backup, it would be a bootable duplicate—an exact copy of your startup
volume, stored on another hard disk, and configured in such a way that
you can boot from that backup drive in the event of an emergency.
Ideally, you should update this bootable duplicate at least once a week
so that it reflects the files that have been added or changed since the
last run.

Lots of software tools provide easy ways to make bootable duplicates.
My favorites are:

 Shirt Pocket’s SuperDuper:
http://www.shirtpocket.com/SuperDuper/ ($27.95)

« Bombich Software’s Carbon Copy Cloner:
http://www.bombich.com/software/ccc.html (free, donations
requested)
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KEEP YOUR SOFTWARE UP TO DATE

Bugs—either in Mac OS X itself or in some application you have
installed—are perhaps the biggest causes of Mac problems. Each new
software release fixes bugs, so keeping your software up to date is an
excellent way of reducing the number of problems you have.

At the same time, each new software version often introduces new
bugs! The release after that fixes those bugs and adds more new ones,
and so on. That’s just how it is, I'm afraid: there’s no such thing as bug-
free software.

In my experience, newer software is almost always better than older
software. A couple of times, I've applied an update and immediately
regretted it enough to revert to the previous version (which sometimes
means reinstalling software from scratch and then applying every
update except the most recent one). But these times have been excep-
tionally rare. The vast majority of the time, I'm happier after applying
an update than I was before.

So in general, my advice is to keep up with new software releases—
including Mac OS X itself (minor updates are available by choosing

®& > Software Update) and third-party applications. In particular, if
you start experiencing crashes, hangs, and other sorts of misbehavior,
I recommend updating your software right away.

I understand and respect the “if it ain’t broke, don’t fix it” school of
thought. Sure, I've heard of people who were computing quite happily
until some software update came along and messed things up for them,
causing them hours or days of grief. Yes, that can happen. But the odds
favor improvements with each update. So, at the very least, think about
installing software updates you may have skipped when you encounter
problems. But if you're willing to undertake a small amount of risk for
a potentially large reward, do what I do and keep up with every new
update.
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Prepare for
an Emergency

You probably carry a spare tire, a jack, and jumper cables in your
car (perhaps along with the phone number for roadside service).
These sorts of basic problem-solving tools are just common sense.
If you don’t have comparable tools for your Mac, you'll be in a
pickle if and when a problem occurs. Don’t get stranded without
the means to get back up and running again.

All the items in this section can come in handy when a problem
occurs. You might not use them all, but I've used each of them
at one time or another, and I've found them all to be sound
investments.

ACQUIRE A SECONDARY STARTUP VOLUME

You can’t replace your car’s oil filter while the engine is running—

it would not only be messy but it could potentially ruin the engine.
Similarly, some repairs can’t be done when your Mac is running from

a disk that’s experiencing problems. In these cases, you must start your
Mac from another volume. You may also need to start from another
volume if your internal hard drive dies completely.

A secondary startup volume can take numerous forms. I prefer an
external hard drive with FireWire and USB interfaces, because it’s fast,
flexible, and can be used for things other than starting up in an emer-
gency. But that is just one of several options. Be sure you have at least
one of these handy:

« A bootable CD or DVD, such as a Mac OS X Install DVD or an
emergency repair disc from a third party. Examples include:

o DiskTools Pro: http://www.macxware.com/site/products/
DiskToolsPro/overview.html ($79.99)

o DiskWarrior: http://www.alsoft.com/DiskWarrior/ ($99.95)
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o Drive Genius:
http://www.prosofteng.com/products/drive_genius.php ($99)

o TechTool Pro: http://www.micromat.com/index.php?
option=com_ content&task=view&id=202 ($98)

« A solid-state disk, such as Micromat’s $229 FireWire-based
TechTool Protégé (http://www.micromat.com/index.php?
option=com_ content&task=view&id=34).

« A suitably partitioned1 external FireWire or USB hard drive or flash
drive. (Note that only Intel-based Macs can boot from USB drives.)

Pod people: Some iPods can also be used as startup disks, as
long as they have enough free space and an interface appropriate
for your computer. Note that iPod hard disks weren’t designed to
run continuously for any amount of time, so it’s fine to use one as
an emergency repair disk, but don’t work from it regularly. You
can learn more about starting up from an iPod in this article from
Apple: http://support.apple.com/kb/HT1478.

« Another Mac that can boot into FireWire target disk mode—
assuming both Macs have FireWire ports. (To make this work,
connect the Macs with a FireWire cable, restart the one whose disk
you want to boot from, and hold down the T key until you see the
FireWire icon; see http://support.apple.com/kb/HT1661.)

« For MacBook Air users, either an external SuperDrive or another
computer (Mac or PC) on the local network (wired or wireless) with
Apple’s Remote Disc software installed. (I describe the latter setup
later, in Start from a Remote Disc, p. 28.)

« A second internal drive (in a desktop Power Mac or Mac Pro)

" Even if a disk has only one partition, it must use the correct partitioning scheme
to be bootable. The choices are GUID Partition Map (the default for Intel-based
Macs), Apple Partition Map (APM) (the only scheme supported for PowerPC-based
Macs), or Master Boot Record (which is never bootable on a Mac). An APM-
partitioned drive can boot either a PowerPC- or Intel-based Mac, but a GUID-
partitioned drive can boot only an Intel-based Mac. To select a scheme when
partitioning a drive in Disk Utility, click the Partition button, click Options, and
select the appropriate radio button.
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« A second partition of your main startup disk

Piece of the action: A second partition is the least useful for
troubleshooting, because it doesn’t enable you to solve problems
that affect the entire disk.

If your secondary startup volume is a Mac OS X Install disc, an up-to-
date third-party repair disc, or a TechTool Protégé, then you’re all set.
But if you're using another disk or partition, you must make sure it
contains a bootable copy of Mac OS X. You can do this in any of the
following ways:

« Clone your internal drive: Using backup software designed
for this task, make an exact copy of your main startup disk on
the secondary disk. Tools that work well for this purpose include
SuperDuper (http://www.shirtpocket.com/SuperDuper/) and
Carbon Copy Cloner (http://www.bombich.com/software/
ccc.html).

« Install Mac OS X directly: In many cases you can insert your
Mac OS X Install DVD or CD and run the installer, selecting your
secondary disk as the destination.

« Use TechTool Protogo: Not to be confused with the similarly
named product (TechTool Protégé) from the same company, this
clever $135 utility installs a bootable copy of Mac OS X (or even Mac
OS 9, on an older machine) and disk repair software (TechTool Pro
and DiskStudio) on any of a wide range of devices, including many
iPods. Especially nice is the fact that it can install a slimmed-down
version of the operating system that fits on devices with as little as
2 GB of free space (http://micromat.com/index.php?option=
com_ content&task=view&id=184&Itemid=105).

After setting up your secondary startup volume, be sure to test it
to verify that it is bootable; you don’t want to find out that it’s not
working after your main drive dies. Read Start Up from Another
Volume for more details.

Note: As I describe ahead, in the sidebar Applelack (p. 17),

a command-line utility called Applelack also provides a way to
repair one’s hard drive, and doesn’t require a separate volume
to do so—but it’s also limited in the range of repairs it can make.
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GET A DISK-REPAIR UTILITY

Over time, almost every disk develops some minor errors that can
cause your Mac to behave badly. The specific causes and symptoms
are numerous, but when disk errors occur, your only option is to use a
utility that’s specially designed to examine your disk at a low level and
repair the problem. (In order to perform most repairs, you must run
the disk utility from your secondary startup volume. See Run Disk-
Repair Utilities for further instructions.)

Apple includes a basic disk utility called (you guessed it) Disk Utility
with Mac OS X. It’s found in /Applications/Utilities and also
appears on every Mac OS X Install disc. If you clone your startup
volume or install Mac OS X directly onto another disk, you already
have one disk repair utility ready to go.

I use Disk Utility frequently, because it’s a quick and easy way to solve
a number of problems and is considered to be extremely safe. But
some disk errors are too complex for Disk Utility to repair, and unfor-
tunately, such errors are not uncommon. So I recommend, if at all
possible, having a second disk repair utility available—one that can
pick up where Disk Utility leaves off. In my opinion, only four are
worth any serious consideration:

« DiskWarrior: My favorite by far, this $99.95 utility from Alsoft
can solve some problems no other utility can. It’s been around for
over 20 years, and has only gotten better over time. If you can buy
only one disk utility, get this one (http://www.alsoft.com/
DiskWarrior/).

« TechTool Pro: Micromat’s $98 flagship repair utility (mentioned
already in connection with TechTool Protégé and TechTool Protogo)
not only repairs disks but also checks your RAM, video card, and
other hardware components (http://www.micromat.com/
index.php?option=com_ content&task=view&id=202).

« Drive Genius: Prosoft Engineering’s $99 Drive Genius doesn’t
have the same long history as the other two candidates, and early
versions had some problems. But it has a solid feature set, and it
can repartition hard disks without erasing their data
(http://www.prosofteng.com/products/drive_genius.php).
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« DiskTools Pro: This newcomer from Macware has a full comple-
ment of disk-repair capabilities, but as of publication time it hadn’t
been out long enough to discern its real-world effectiveness
(http://www.macwareinc.com/products/DiskToolsPro/
overview.html, $79.99).

Each of these comes with a bootable emergency DVD, and can be
installed on your secondary startup volume.

Applelack

There’s a (partial) exception to the rule that you can’t repair

the disk you're booted from. If you install the free command-line
utility Applelack, available from http://applejack.sourceforge.net/,
you can run several basic disk repair procedures (essentially the
equivalent of Disk Utility’s Repair Disk and Repair Disk Permissions
features, plus clearing cache and virtual memory swap files,

and checking preference files for validity) by booting your Mac

in single-user mode.

To do this, hold down Command-S while restarting until the Apple
logo appears. Your screen then fills up with text, and when the
boot process has finished, you type applejack, press Return, and
follow the on-screen prompts.

Applelack is well worth installing so that you have it ready as

an alternative repair method in the event you're stuck without
another startup disk for some reason. However, be aware that
Applelack is much less capable than commercial utilities such

as DiskWarrior and TechTool Pro, and that it can’t help you if the
portion of your disk that contains the AppleJack software itself (or
certain other essential components) is corrupted—or if the drive
mechanism is physically damaged or electronically malfunctioning.
Given the choice, I always recommend starting from another
volume and using a full-featured repair program.
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A Little Something Extra

If you want a truly complete troubleshooting toolkit, consider
adding a few optional items to help with certain specific problems.
For example:

e A spare keyboard and mouse: If your input devices aren’t
working, it’s hard to do anything with your Mac—including
troubleshooting. Even old, cheap, or used input devices are
good enough for emergency use.

e Extra cables: When you're troubleshooting network problems,
a spare Ethernet cable is handy. When peripherals malfunction,
an extra USB or FireWire cable can help you rule out a bad
cable as the cause. As a bonus, a FireWire cable can be used
to network two Macs together if they both have FireWire ports.

e Batteries: If you use Bluetooth devices or other wireless
accessories, have a spare set of batteries available. Batteries
have a way of dying at the most inopportune times!

SET UP ANOTHER USER ACCOUNT

Your home folder (/Users/your-user-name) contains all the files

that are specific to your account, including not only your documents,
pictures, and music but preference files, caches, and certain kinds of
application support files and system add-ons. If you're the only person
who uses your computer, you may have only one login account and
therefore just one home folder on your computer.

Regardless of how many users your Mac has, I suggest setting up
another account that you’ll use solely for troubleshooting. That way,
when a problem arises, you can easily switch to the other account—
which will have default settings for everything—and see whether the
problem still occurs. If it doesn’t, you know the cause is to be found
somewhere in your home folder, and you can begin narrowing it down
from there.

Tip: To learn all about user accounts, including much more detail
on how to use a troubleshooting account to check for things like
conflicting login items and preference files, read Kirk McElhearn’s
Take Control of Users & Accounts in Leopard.
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To set up a troubleshooting account, follow these steps:

1. Open the Accounts pane of System Preferences.

2. Click the lock icon and enter your user name and password.
3. Click the| +!button just below the list of accounts.

4. Enter the requested information: name, short name, password
(repeated for verification), and an optional password hint.

5. In Tiger, be sure the Allow User To Administer This Computer box
is checked; in Leopard or later, choose Administrator from the New
Account pop-up menu.

6. Click Create Account.

What’s in a name: Your troubleshooting account won'’t do you
much good if you can’t remember its user name or password. So pick
things you’ll remember. Something as simple as “Test User” for the
long name and “test” for the short name is fine.

Because this new user has administrative privileges, the password
should be as secure as the one set for your own account—if you set

an easy password (like “test” again), you're putting your Mac at risk.
My advice: set same password that you use for your normal adminis-
trator account to make it memorable yet secure.

CONSIDER PURCHASING APPLECARE

The AppleCare Protection Plan is essentially an extended warranty
you can buy for a new Mac. Normally, Apple offers a 1-year limited
warranty on its computers, including 9o days of telephone support.
AppleCare extends the warranty (and the telephone support) to a full

3 years. AppleCare also gives you a bootable CD or DVD with TechTool
Deluxe (a stripped-down version of TechTool Pro).

Depending on which equipment you purchase, AppleCare can cover
peripherals (such as displays and AirPort base stations), and for desk-
top Macs, it even includes onsite service in most areas. The cost for
AppleCare depends on your hardware; it ranges from $149 (for a Mac
mini) to $349 (for a laptop).
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I can’t emphasize strongly enough what a great idea AppleCare is.
During one recent year, my mother, my wife, and I all had faulty iMac
logic boards replaced—at no additional cost—thanks to AppleCare;
without it, the machines would have been out of warranty and we would
have spent many hundreds of dollars for the repairs. It’s especially use-
ful (though more expensive) for laptops, which tend to be more trouble-
prone than desktop computers. If you don’t live close to an Apple Store
or an authorized repair center, Apple will send you a prepaid shipping
container in which to return your laptop for repair.

You can purchase AppleCare when you buy your computer, or at

any time before your initial 1-year warranty expires. You don’t have
to buy it from Apple; some resellers, such as Small Dog Electronics
(http://www.smalldog.com/), often sell it for less than Apple does.
Because it provides not only hardware repairs but also (usually) com-
petent telephone tech support, I heartily recommend AppleCare to
everyone buying a new Mac.

Go Pro

If you live near an Apple Store, consider buying a $99 annual
subscription to Apple’s ProCare service (http://www.apple.com/
retail/procare/). ProCare includes numerous benefits for Apple
Store customers, including priority service at any Genius Bar,
faster repairs, and an annual Mac tune-up. The plan covers up

to three computers registered in your name. Although ProCare
doesn’t cover out-of-warranty hardware repairs, it can be a faster
and more effective way than AppleCare to get technical support.
(And, of course, you can sign up for both programs if you wish.)

THINK ABOUT AN INSURANCE POLICY

I realize this is a somewhat different category of preparation, but there
are some serious computer problems—such as theft or accidental
breakage—that no amount of troubleshooting can fix. To protect your
investment in cases like these, consider buying a special insurance
policy just for your computers.

You may already have homeowner’s or renter’s insurance that
covers your computer in the event of fire, flood, or burglary. But
read your policy carefully, since you may be surprised to learn that
many common types of loss are usually not covered—things like
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accidental damage or theft from a car. (And, in cases like these,
your Apple warranty or AppleCare plan is of no use either.) Policies
geared specifically for computers can fill that gap.

A true story: a number of years ago, I was carrying a PowerBook in

a padded laptop bag. The bag slipped off my shoulder and hit a rock,
and the computer’s display cracked. Because I had a computer insur-
ance policy, though, I saved hundreds of dollars on the costly repair—
even after factoring in the deductible and the cost of the policy itself.

Safeware (http://www.safeware.com/) is the best-known source

for computer insurance in the United States. They offer a range of
policies that cover desktops, laptops, and peripherals, and they even
include coverage for theft from an unattended vehicle. In the UK,
comparable policies are available from companies like Insure & Go
(http://www.insureandgo.com/computer-insurance.html) and
CompuCover (http://www.compucover.co.uk/).

FIND EXTRA HELP

Last but not least, figure out whom you can call or email for advice
when you can’t solve a problem on your own (even with this book).

Phone a Friend

If you ask around, you may find someone in your existing circle of
contacts who knows a thing or two about solving Mac problems. But

if your go-to person is a friend or family member (in other words,
someone who doesn’t charge for their services), I have three additional
pieces of advice:

« Don’t start with a problem: Ahead of time—when your Mac is
working—ask your friend if he or she is willing to field occasional
tech support questions. You might even invite the person over to
dinner to get acquainted with your setup in advance.

« Don’t abuse free help: Even the most knowledgeable and
generous friends can get annoyed when requests for help are too
frequent or too time-consuming.

« Return the favor: As someone who has provided more than his
fair share of free tech support to friends and family, I can’t tell you
how much it improves my attitude when someone returns the favor
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in even a small way. I've had people invite me out to lunch; offer
accommodations when I'm traveling in their area; lend me their car
for a day; and send me coffee, chocolate, CDs, and other thank-you
gifts. Small gestures like these are good for relationships as well as
your computer’s health!

You’re my friend, aren’t you, Joe? I always include my email
address in my books, and countless people have written to make
comments, ask questions, or suggest new topics to cover. That’s
great—I enjoy hearing from readers, and I do my best to reply as
quickly as I can. However...

Occasionally a simple inquiry turns into a lengthy series of questions.
I've even had people email or phone me—at all hours of the day and
night—begging me to help solve a problem that happens to be related
in some way to a book or article I've written. I don’t mind answering
brief questions, but I don’t have the time to provide extensive
technical support to everyone who asks, much as I'd like to.

However, I do make part of my living as a Mac consultant, and if you
are so inclined, you can hire me to help. Please be aware that I charge
$100 per hour and that I'm often too busy to take on new projects, so
I may sometimes have to refer you to a colleague—but feel free to
inquire if you're interested.

Ask at a User Group

At Mac user groups all over the world, ordinary folks meet to learn
about the latest products, find better ways of working, and help each
other solve problems. I’'ve been an active member of several user
groups over the years, and I frequently give presentations at user
group meetings (usually covering topics I've written about for Take
Control). Most user group meetings are open to the public, and some
offer additional benefits for paid members. To find a user group in
your area, see http://www.apple.com/usergroups/find/. (That page
also lists groups that meet only online.)

Find a Consultant

If you don’t know anyone who’s a Macintosh expert or have a local
Mac user group, never fear. Thousands of independent consultants
make their living solving Mac problems. These folks may not be able
to perform certain kinds of hardware repairs (see Go to the Source,
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below, if that’s what you need), but they can fix most Mac problems
you encounter.

To find an Apple-certified consultant in your area, search the Apple
Consultants Network site at http://consultants.apple.com/consultant/
search.html. Of course, lots of highly competent professionals offer Mac
consulting services without having gone through Apple’s certification
program. You can often find such folks in the Yellow Pages or by
searching the Web.

Call the doctor: Bob “Dr. Mac” LeVitus, a well-known Mac author,
runs an online consulting service with a staff of highly trained
troubleshooting whizzes. If your problem doesn’t require someone to
be physically present, you may find that this service is just what the
doctor ordered (http://www.boblevitus.com/).

Go to the Source

Some problems (particularly hardware defects) require special equip-
ment, software, or training that only a certified Mac repairperson can
provide. When that’s what you need, choose one of the following:

« A Mac Genius: If you live near an Apple Store, you can talk

your problems over with an Apple-trained expert at its Genius Bar.
The advice is free, but if your Mac needs repairs and is not covered
by a warranty or AppleCare, you’ll have to pay for parts and labor.
At some busy Apple Stores, you may need to make an appointment
to speak to a Mac Genius—call first or visit the store’s Web page if
in doubt. Remember that paying $99 for ProCare, Apple’s priority
support program at Apple Stores, helps you avoid the lines and get
other benefits. See the tip Go Pro for more information.

« An Apple Authorized Service Provider: If there’s no Apple
Store nearby, seek out a computer shop that’s authorized to provide
warranty (or AppleCare) service on your Mac; they’re also the best
(that is, least expensive) choice for out-of-warranty service. You
can search a directory of AASPs in the United States at
http://www.apple.com/buy/locator/service.html; for AASPs in
other countries, visit http://docs.info.apple.com/article.html?
artnum=304398.
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HAVE A PRINTED COPY OF THIS BOOK

One last little detail. When it comes time to solve problems, you may
not be able to use your Mac at all, so if you're reading the PDF version
of this book on your Mac, you won’t be able to refer to it. So, consider
printing the remainder of this book, ordering a printed copy (click
Order Print Copy on the cover—you’ll get a $10 discount because you
already bought the PDF), or transferring the electronic file to another
computer, an iPhone, an iPod touch, or some other device on which
you can view it even if your Mac isn’t cooperating.
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Learn Basic
Troubleshooting
Procedures

If I were teaching you how to cook, I'd start by making sure you
knew the basic techniques you’d be repeating many times: how

to julienne vegetables, deglaze a pan, cream butter, roast poultry,
and so on. That way, when we got to specific recipes later, I could
simply say, “sweat the aromatics in butter and puree the tomatoes’
without having to explain the meanings of words like “sweat,”
“aromatics,” and “puree.”

>

I want to do the same thing in this section: make sure you have

a grasp of all the procedures that come up in many different Mac
troubleshooting tasks. Then, when I describe the specific steps
you’ll follow to solve various problems, I can say, “start up in Safe
Mode” without having to spell out that process every time. And
of course, you can always follow links back here if you need a
reminder of what I'm talking about.

If you’ve been using Macs for any length of time, you may raise
your eyebrows at some of the procedures just ahead. “Restart Your
Mac? Is he kidding? Who doesn’t know how to restart a Mac?” But
please read through those sections anyway, because they include
details that may not be obvious (such as what to do if the usual
means of restarting doesn’t work).

RESTART YOUR MAC

Restarting is the most powerful Mac troubleshooting technique I
know. This simple procedure can resolve a huge variety of crashes,
hangs, and other problems. It may not be the first thing you should try

(because it takes a few minutes), but it should certainly be high on your

list. So when the need to restart arises, try each of these methods in
turn until you succeed:
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1. The menu command: Choose & > Restart. When the
confirmation alert appears, click the Restart button.

Quicker restarting: Another way to restart is to press your
computer’s power button, which displays a dialog with four
buttons (Restart, Sleep, Cancel, and Shut Down). When this dialog
appears, you can either click the Restart button or simply press the
R key to restart immediately, without the confirmation alert.

Mac OS X then instructs all running applications and background
processes to quit. After a few seconds (or, in some cases, as long as
a few minutes—if whatever’s running takes a while to respond), the
screen goes blank, the startup chime plays, and the Mac restarts.

In some situations, restarting in this way isn’t possible. Perhaps
the @ menu won’t drop down, or your Mac is completely frozen
and won’t respond at all. Or maybe the Restart command appears
to take, but 10 minutes later the machine is still chugging away.
When this happens, move on to...

2. The keyboard shortcut:

« If your keyboard has a power button, hold down Command and
Control and press the power button.

« If your keyboard doesn’t have a power button, hold down
Command and Control and press the eject key (typically found
in the upper right corner of the keyboard, and if it’s not labeled,
try either F12 or F15). Usually this method causes your Mac to
restart immediately.

If that doesn’t work, try...

3. The brute-force method: Press and hold the Mac’s power button
(sometimes the power button on Apple monitors works too) for
approximately 10 seconds, or until the power light goes out com-
pletely. (If you don’t hold it long enough, you may just put your
computer to sleep, as indicated by a pulsating power light.) Then
press the power button again to turn your Mac back on.
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FORCE-QUIT AN APPLICATION

When an application gets stuck and its regular Quit command won’t
work, you can usually quit it using Mac OS X’s Force Quit feature. To
do this, press Command-Option-Escape (or choose @ > Force Quit).
Select the program you want to quit and click Force Quit. You can then
close the Force Quit Applications window.

Tip: You can often force-quit a stuck application without the Force
Quit Applications window. Option-click its Dock icon and choose
Force Quit from the pop-up menu to quit the application.

Sometimes, even after you use the Force Quit command, a program
keeps running. When this happens, a second attempt at force-quitting
nearly always does the trick. Close the Force Quit Applications window
if it’s still open, and repeat the force-quit procedure.

If even the second attempt doesn’t work, or if you can’t bring up the
Force Quit Applications window, your best bet is to Restart Your Mac.

Finders keepers: The Finder appears in the Force Quit Applications
window along with your other applications. But when you select it,
the button changes from Force Quit to Relaunch. That’s because Mac
OS X is designed so that the Finder is always running. If you quit it—
which you may need to do if it gets stuck—it automatically attempts
to open again.

START UP FROM ANOTHER VOLUME

If your main startup volume has problems that can’t be repaired while
Mac OS X is running from it—or if the drive dies completely and you
need to start from a bootable duplicate—use one of these procedures to
start up from another volume.

Start from a CD or DVD

To start your computer from a CD or DVD, follow these steps:

1. If your computer is running, insert the disc containing a bootable
copy of Mac OS X. Then choose @& > Restart, and skip to Step 3.
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2. If your computer is off, press the power key and immediately insert
the disc. (On some Macs, you may have to press the Eject button on
your keyboard to open the drive tray. Do this, and insert the disc, as
quickly as you can.)

3. Immediately hold down the C key on the keyboard.

4. When the gray Apple logo appears in the center of the display,
release the C key.

Keep in mind that the startup process takes considerably longer with a
CD or DVD than it does with a hard disk.

Start from Another Hard Disk or Partition

If your secondary startup volume is on another hard drive (or a
partition of your main disk), follow these steps:

1. If you haven’t already done so, attach the drive to your computer.

2. Restart, holding down the Option key until icons for all the valid
startup volumes appear on the screen. (If your Mac refuses to
display the startup volumes, restart again, this time holding down
Command-Shift-Option-Delete.)

3. Using the mouse or the arrow keys on the keyboard, select the
volume from which you want to boot. Then:

e On an Intel-based Mac, click the arrow icon underneath the
selected volume or press Return.

« On a PowerPC-based Mac, click the button with the right arrow
icon or press Return.

Note: When you choose a new startup volume using the method
described here, that choice applies only once. The next time

you restart, if you don’t hold down any extra keys, you’ll start
up from your previously selected volume. To make the change

in startup volume persist past a single restart, go to the Startup
Disk pane of System Preferences and pick a new startup volume.

Start from a Remote Disc

The MacBook Air was the first Mac in many years to include neither
a FireWire port nor a built-in optical drive (even as an option), which
reduces its range of startup options. Unlike most Macs, however, the
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MacBook Air can boot over a network (a Wi-Fi network or, if you have
the optional USB Ethernet adapter, a wired network) from a startup
CD or DVD loaded on another computer—Mac or PC—on your
network.

To do this, you must first install the Remote Disc software (included
with your MacBook Air) on the other computer, following these
directions on Apple’s Web site: http://support.apple.com/kb/HT1777.
Then, insert the disc you want to boot from in the other computer, and
on your MacBook Air, select that disc in the Startup Disk pane of
System Preferences and restart.

Note: If you don’t have another startup disk available but you
did install Applelack (see the sidebar Applelack, p. 17), you can
restart while holding down Command-S to start in single-user
mode and run Applelack.

RUN DISK-REPAIR UTILITIES

All the disk-repair utilities I mention in this book are easy to use.

In general, it’s simply a matter of booting from a secondary volume,
running the program (some of them launch automatically), selecting
a drive (or volume), and clicking a button. (Some applications let you
choose among a variety of tests to perform; when in doubt, run them
all!) Consult the documentation included with your utility for details.

I do want to point out one slightly tricky thing: running Disk Utility
from a Mac OS X Install CD or DVD. To do so, follow these steps:

1. Boot from the CD or DVD.
2. Click through the language selection screen.

3. Choose Utilities > Disk Utility.
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ERASE AND RESTORE FROM BACKUP

In the unlikely event that neither Disk Utility nor a third-party utility
can repair the problems with your disk, your only option is to erase the
disk and start over:

« If you have a bootable duplicate, this is easy. Start up from the
duplicate, use Disk Utility to erase your primary startup disk, and
then use your duplication software to copy the backup back onto the
disk you normally use.

« Ifyou don’t have a duplicate, make one if possible. (See Back Up
Your Mac Regularly.) If your Mac won’t boot normally, you might
still be able to boot it in FireWire target disk mode if it has a
FireWire port. To do this, restart and hold down the T key until
the FireWire icon screensaver appears. Then use another Mac and
external hard disk to make a duplicate of the ailing Mac’s hard disk.

« Ifyou can’t make a duplicate, back up your files as best you can.
Then start up from your Mac OS X Install disc and run the installer.
On the screen where you select the volume to install Mac OS X on,
click Options and select the Erase and Install option. Be aware that
this will erase everything on that disk—but at this point, you may
have no other choice.

REPAIR PERMISSIONS

Every file on your Mac has a collection of settings specifying which
users can perform various actions with it (including reading, writing,
and executing). The files that make up Mac OS X itself (including some
Apple-installed applications) have very particular permission settings,
and if they get changed from what they were originally, things can go
wrong. For example, applications may refuse to open, printing may
stop working, and you may even be unable to log in.

Permissions don’t change themselves. Something has to happen to
change them—such as running an improperly written installer or doing
injudicious fiddling in Terminal. But whatever the cause, out-of-whack
permissions can be nasty.

Disk Utility includes a command to restore certain permissions to
what they were originally. This command affects only about 50 soft-
ware packages (including the core elements of Mac OS X). It doesn’t
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change the permissions for any third-party software, and it only resets
permissions to what they were originally—which could, in theory, have
been wrong. So it’s not the cure-all that many pundits have proclaimed
it to be. But it can solve real problems, including problems that involve
third-party software (which depends on parts of Mac OS X that must,
in turn, have the correct permissions).

To repair your permissions, follow these steps:
1. Open Disk Utility (in /Applications/Utilities).

2. In the list on the left, select the disk or volume whose permissions
you want to reset, as shown in Figure 1, where I've selected my
volume called Leopard. (Permissions can be repaired only for
volumes or disks containing Mac OS X.)
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Figure 1: Repair permissions by selecting a disk and clicking the
Repair Disk Permissions button.
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3. In the First Aid pane, click Repair Disk Permissions.

Disk Utility displays messages about what permissions, if any, it resets
in the status area.

Repairing Permissions: The Great Debate

No Mac troubleshooting procedure has received more press or
been the subject of more debate—both pro and con—than Disk
Utility’s Repair Disk Permissions feature. My experience is that
repairing permissions occasionally solves random problems, and I
am unaware of it having ever caused problems on my Macs. But it
is by no means a panacea, nor is it the first thing I suggest trying
when something goes wrong.

The best account I've read about repairing permissions

was written by Take Control editor Dan Frakes in “Repairing
permissions: What you need to know,” published in Macworld
(http://www.macworld.com/2006/08/secrets/repairpermissions/).
To learn more about permissions generally, read Brian Tanaka’s
Take Control of Permissions in Leopard.

START UP IN SAFE MODE

As you use your Mac over a period of months and years, chances

are you'll install a variety of third-party software. Some of this software
may include components that operate at a low level and must be
running in the background all the time—things like drivers for third-
party input devices, certain backup programs, audio capture software,
and utilities that monitor your Mac’s performance. All these things
may load and run every time your start your computer without your
ever being aware of them. And when they work, they’re great. But

if something goes wrong with one of them, it’s not always clear what
the problem is or how to turn off the offending software.

For reasons like this, Apple provides a special way to boot into Mac OS
X called Safe Mode (and getting into that mode is called performing a
Safe Boot). A Safe Boot temporarily disables most of these third-party
items (as well as several Apple products). In Mac OS X 10.4 Tiger or
later, it also disables any login items (programs or documents listed in
the Login Items view of the Accounts system preference pane), which
normally open when you log in. By turning off all these items, you can
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eliminate many potential glitches, and if the problem you were experi-
encing stops after a Safe Boot, you have some important clues as to
what the culprit is.

Safe Mode Details

Apple’s Web site has complete information about what happens
(or doesn’t) during a Safe Boot. If you want to know the details,
see http://support.apple.com/kb/HT1564.

To perform a Safe Boot, follow these steps:

1. Turn off your computer. (Seriously: don’t just restart. Choose & >
Shut Down or press the power key and click Shut Down in the
dialog that appears.)

2. Press the power key to turn your computer back on.

3. As soon as you hear the startup chime, press the Shift key and hold it
down until the gray Apple logo appears in the center of the screen.

Your Mac will complete the startup process, which may take consid-
erably longer than usual. You’ll eventually see the words “Safe Boot”
on the screen—possibly within the login window, depending on which
version of Mac OS X you’re running.

TURN OFF LOGIN ITEMS

Although Safe Mode disables not only (system-wide) startup items
but also (user-specific) login items, you may wish to disable only your
login items. For example, if your problem went away during a Safe
Boot, you might try a normal boot but with login items disabled, to
narrow down which of the recently disabled items might be at fault.

You could open the Accounts pane of System Preferences, go to the
Login Items view, and delete everything in the list, but don’t—it’s
overkill, and it can be tedious to replace those items later. Instead,
disable them temporarily.

To disable login items:
« If your computer is currently running:

1. Choose @& > Log Out User-Name and click Log Out to confirm
that you want to log out.
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2. Select (or type in) your user name and password.

3. Click Log In and then immediately press Shift.

4. Release the Shift key when your Desktop appears.
« If your computer is off:

1. Press the power key to turn on your computer.

2. Press and hold the Shift key immediately after your Mac begins
logging you in:

« Ifyoulogin by entering your password, press Shift imme-
diately after entering your password and clicking Log In.

« Ifyou have configured your account to log you in
automatically, then in Tiger, press the Shift key as soon as the
startup progress bar appears. In Leopard or later, press the
Shift key as soon as the gray Apple logo disappears; this
disables automatic login. In the login window, select (or type
in) your user name and password, click Log In, and then
immediately press Shift again.

3. Release the Shift key when your Desktop appears.

CHECK PREFERENCE FILES

When an application starts acting funny, one of the first things to
suspect is a damaged preference file. There are two ways to discern
whether a preference file has problems; we start with the easy way.

Use Preferential Treatment

A free utility by Jonathan Nathan called Preferential Treatment
(http://www.jonn8.com/html/pt.html) scans all your preference
files, looking for obvious syntax errors. If it finds a file with problems,
it lets you delete it immediately or reveal it in the Finder so that you
can disable it manually.

To use Preferential Treatment:

1. Quit the application that’s experiencing problems, and launch
Preferential Treatment.
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2. Click the lock icon at the top, and enter your administrator pass-
word. Preferential Treatment immediately starts checking your
user preference files (those stored in ~/Library/Preferences).

If Preferential Treatment finds any preference files with potential
errors, it lists them, with the errors in red. (Not every suspected
error is a genuine problem. Some developers, for example, continue
to use a now-obsolete file format. Figure 2 shows an example.)

Multiple birds, single stone: Preferential Treatment scans all
your preference files, so it may identify problematic files for appli-
cations other than the one that’s currently misbehaving. But it
doesn’t hurt to deal with those, too, as long as you're here; that’ll
reduce the risk of further problems later.

N ele) Preferential Treatment

| User Preferences  System Preferences |

S s

"E"" f Check User Preferences |
Flagged User Preterence Files Prablems
fUsers/jk/Library/Preferences/ XML parser error: Unexpected
com.Bathwin.5ocial.plist character at line )

Oid-style plist parser error

Unexpected character "0x0° at line 1
fUsers (jk/Library fPreferences XML parser error: Unexpected
com.Inceneares Exocarp.plist character at line 1

Old-style plist parser error
Unexpected character "0x’ at line 1

{Users/jk/Library/Mail/Bundles f XML parser error: Found non-key
MailactOn.mailbundie /Contents/ inside <dict> at line 27

Resources)/ Oid=style plist parser error
actOnSyncKeyToMallKey, plist Malformed data byte group at line 1;

e

Figure 2: Preferential Treatment lists preference files that have
potential errors; this may include some that merely use an old or
nonstandard format (such as the ones shown here).

3. Select a flagged preference file and choose your desired response
from the pop-up action menu:

« Ifyou’re certain that the file is damaged and that you can live
without its contents, choose Move to Trash. (But be careful:
trashing a preference file can require you to reconfigure an
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application and even, in some cases, re-enter your license code
or other registration details.)

« Otherwise, choose Reveal in Finder, and then manually drag
the file to your Desktop.

4. Go to the System Preferences pane in Preferential Treatment. If
the lock icon is locked, click it and enter your administrator pass-
word again; otherwise, click Check System Preferences. Preferential
Treatment scans the preference files stored in /Library/
Preferences.

5. Repeat Step 3 with any flagged preference files.

6. Open the problematic application again. It creates a new, default
preference file (or files) for itself.

7. Test the application to see if the problem still exists. If not, the old
preference file was probably at fault, so you can trash the one on
your Desktop. If the problem is still there, the preference file was
probably good—so you can quit the application and drag the file
from your Desktop back to where it came from.

Preferential Treatment is easy to use, but it doesn’t identify all possible
problems with preference files. For example, it doesn’t work on files for
which the developer has used a nonstandard format, and it identifies
only syntax errors—just one source of problems. If the results of using
Preferential Treatment are inconclusive, your next step is to manually
disable the preference file temporarily.

Manually Disable Preference Files

Before you can disable a preference file, you need to find it. And
that’s sometimes easier said than done. Most preference files live

in one of two folders: ~/Library/Preferences or /Library/
Preferences. Those folders, however, can have hundreds or even
thousands of items in them, and they may not conform to any obvious
organizational scheme.

Apple recommends that preference files follow a standard naming
convention, known as reverse-URL naming. You take a company’s
domain name and reverse it—apple.com becomes com.apple—

and then you add the name of the application. Finally, you add the
extension plist (for property list). So, com.apple.mail.plist isthe
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preference file for Mail, and com.microsoft.Word.plist is the
preference file for Word. That’s a bit weird, but at least it makes sense.
Unfortunately, this system doesn’t always work:

Some developers use their own naming conventions.

Some applications have several different preference files, each for a
different sort of data. These files might be stored in a folder inside
your Preferences folders, or they might not—and if they are in a
folder, there’s no telling what that folder might be named. (The
name of the application or the name of the developer are two good
initial guesses.)

Applications may change the formats or names they use for
preference files from one version to the next, making it unclear
which of several candidates is the right one.

Your Preferences folders may contain files that are not preference
files—log files, lists of recently opened documents, and so on.

So, to locate the preference file for a given application, try each of these
steps until you find it:

1.

Open ~/Library/Preferences and set the window to List View
(View > As List). Click the Name column to sort the list by name.

Scroll down to where the application’s name would be if it followed
the reverse-URL format. Look for adjacent files, too, in case the
application has more than one.

. Type a portion of the application’s name in the window’s Search

field (for versions of Mac OS X that have one), or use Mac OS X’s
Find command (File > Find). If that yields no results, repeat with
a portion of the developer’s name.

If you find more than one potential match, check the modification
date. Usually the file or folder modified most recently is the one
you’re looking for.

. If you still haven’t found the file(s), repeat Steps 1—3, but this time

look in /Library/Preferences.

Once you've located the file(s), then what? Well, you could drag them
to the Trash, but I wouldn’t. If the file isn’t faulty after all, you may find
yourself having to reset lots of preferences for no good reason. In some
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cases, that might mean digging out your license code and reentering
your registration data. Instead, I suggest moving the file(s) temporarily
to your Desktop. Follow these steps:

1. If the application is running, quit it.
2. Drag the preference file(s) to your Desktop.

3. Open the application again. It creates a new, default preference file
(or files) for itself.

4. Test the application to see if the problem still exists. If not, the old
preference file was probably at fault, so you can trash the one on
your Desktop. If the problem is still there, the preference file was
probably good—so you can quit the application and drag the file(s)
from your Desktop back where they came from, replacing the
preference file(s) created in Step 3.

RESET PMU, SMU, SMC, NVRAM, OR PRAM

Every Mac has at least one chip that stores certain small bits of
information even when the power is off. Depending on your Mac
model, it may have a PMU (power management unit), SMU (system
management unit), SMC (system management controller), NVRAM
(non-volatile RAM), PRAM (parameter RAM), or some combination
of these. Although it’s uncommon, any of this memory can become
corrupted, leading to symptoms including problems turning on,
sleeping, or waking up; excessive fan noise; not displaying video;
and, for portables, not recognizing or charging a battery.

In the event that you encounter such symptoms, I'd like to tell you
how to reset these various sorts of memory, but the instructions vary
significantly from one Mac model to the next. Also, in some cases a
single technique can reset all the relevant chips, while in other cases
you may have to follow one procedure for, say, the SMU and another
to reset the PRAM. So instead of spending several pages laying out all
the details, I've listed the pages on Apple’s Web sites that describe the
reset procedures for each product line:

« MacBook, MacBook Pro, or MacBook Air:
http://support.apple.com/kb/HT1411

« Mac mini: http://support.apple.com/kb/HT2183
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e Mac Pro: http://support.apple.com/kb/HT1806

« iMac G5: http://support.apple.com/kb/HT1767

« PowerBook or iBook: http://support.apple.com/kb/HT1431
« Power Mac G5: http://support.apple.com/kb/HT1436

« All other models: http://support.apple.com/kb/HT1379

Forewarned is forearmed: If the time comes that you need this
information, you may be unable to turn on your computer to read
these instructions! So I recommend printing out the page that applies
to your computer and keeping it handy, just in case.

USE ACTIVITY MONITOR

You may think that your Dock shows you all the applications that are
currently running, but dozens or even hundreds of other background
processes could be running too. Most of these are components of Mac
OS X that use system resources only when needed and stay out of the
way the rest of the time. But sometimes, a rogue program can start
chewing up RAM or CPU cycles and not playing nice with others. If
this happens, your whole computer can slow down. To find out what’s
happening behind the scenes, turn to Apple’s handy Activity Monitor,
which you can find in /Applications/Utilities.

Activity Monitor can tell you all sorts of things about your CPU, RAM,
Disk, and Network activity. But for troubleshooting purposes, I want to
focus on just a couple of pieces of information.

The default view in Activity Monitor (Figure 3) lists all your current
processes; you can sort and filter these in various ways. I typically click
the CPU column header to display processes in order of their CPU
usage. (When the arrow in the header points down, the most CPU-
intensive tasks appear at the top; to change the sorting direction, click
the header.) To see which processes are using the most RAM, click the
RSIZE column header (labeled Real Memory in versions of Mac OS X
prior to Leopard). Regardless of how you sort the display, it updates
periodically.
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Figure 3: Among the many things Activity Monitor can show is
which applications (even ones not normally visible) are using the
most CPU power and RAM.

I should warn you not to jump to hasty conclusions based on what you
see in this window. The fact that a process is using a lot of resources
for a while isn’t necessarily a sign of a problem. But it can be useful for
identifying certain issues. For example, if Safari is running in the back-
ground with a few tabs open and it’s still near the top of the list in CPU
or RAM usage, that could mean you have encountered a bug. Close
some tabs (or quit Safari and relaunch it) to free up those resources.

This list can also help you figure out which background applications
you may have installed and then forgotten about. If one of these is
being a CPU hog, consider checking for an update or uninstalling it.

You can quit processes from within Activity Monitor too. To do so,
select a process and click the red Quit Process button in the toolbar.
Then click Quit. (If that doesn’t stop the process, repeat the procedure,
but click Force Quit.) If you're not the process’s owner, Activity
Monitor prompts you to enter an administrator password.
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Warning! Don'’t quit processes that are owned by root (which
could disable Mac OS X, requiring a restart), and don’t quit the
WindowServer process (which will log you out immediately). You
can tell which user owns a process by looking in the User column.

CHECK FREE DISK SPACE

Mac OS X needs plenty of room on your hard disk for things like
virtual memory and software updates, and all sorts of bad things can
happen if you have too little: kernel panics, crashes, hangs, slowdowns,
and so on. You should never have less than 1 GB of disk space availa-
ble, and even that is cutting it extremely close—5 GB or greater is a
more reasonable minimum amount of breathing room. (Some people
suggest leaving a certain percentage of your disk space, typically

10 percent, free, but this logic doesn’t scale well to very small or very
large disks.) If necessary, delete unneeded files to free up extra space.

If you're at a loss to know which files you can safely delete, allow me to
offer some suggestions:

« Try any of several utilities that show you the size of each folder or
file on your Mac, enabling you to quickly identify and delete large
files you may not be aware of. For example:

o Baseline: http://www.mildmanneredindustries.com/baseline/

($20)
o Daisy Disk: http://www.daisydiskapp.com/ ($19.95)
o Disk Inventory X: http://www.derlien.com/ (free)

o GrandPerspective: http://grandperspectiv.sourceforge.net/
(free)

o JDiskReport: http://www.jgoodies.com/freeware/jdiskreport/
(free)

o OmniDiskSweeper: http://www.omnigroup.com/
applications/omnidisksweeper/ (free)

o WhatSize: http://www.id-design.com/software/whatsize/
(812.99)
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Of these, my current favorite is Disk Inventory X (Figure 4), which
not only gives you a graphical overview of file sizes but also lists all
folder sizes and offers an overview of space usage by file type.
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Figure 4: When you can’t figure out where all those large files are
on your disk, consult a utility such as Disk Inventory X.

Finding, and deleting, duplicate copies of files on your disk can
sometimes free up a good bit of space with no downside at all. To
locate duplicate files, you can use utilities such as these:

o Chipmunk: http://www.chipmunk-app.com/ ($24.95)

o Hazel: http://www.noodlesoft.com/hazel.php ($21.95)

o Tidy Up: http://hyperbolicsoftware.com/TidyUp.html ($30)
Deleting caches is always a safe choice; see Clear Caches.

If you download stuff from the Web frequently, check your Web
downloads folder to see if it contains anything you no longer need,
such as installers for software you've already installed. By default,
Safari uses your Downloads folder for downloads (previously the
Desktop folder was the default), but you can check Safari’s current
location by choosing Safari > Preferences, clicking the General icon,
and looking in the Save Downloaded Files To pop-up menu. Other
Web browsers may have different download folders; check their
preferences for locations if you're unsure.
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« Your ~/Documents folder probably contains some files you no longer
need. Skim the contents of this folder and its subfolders, looking for
documents you have no further use for, and drag them to the Trash.

« Lookin /Applications (and /Applications/Utilities) for any
software you've installed over the past year but never use. (Expired
demo software, anyone?) While you're at it, look through /Library,
/Library/Application Support,~/Library, and ~/Library/
Application Support for folder names matching the applications
you just removed, and delete them as well. Resist the temptation to
delete Apple software that came with Mac OS X, though; you may
need it later.

If you find it too cumbersome to uninstall software manually like
this, or if you're concerned that you might miss some pieces, try an
uninstaller utility, such as one of the following:

o Amnesia: http://koingosw.com/products/amnesia.php ($9.95)

o AppDelete: http://reggie.ashworth.googlepages.com/appdelete
(free)

o AppZapper: http://www.appzapper.com/ ($12.95)
o CleanApp: http://www.synium.de/products/cleanapp/ ($13)
o Hazel: http://www.noodlesoft.com/hazel.php ($21.95)

o Spring Cleaning: http://www.smithmicro.com/default.tpl?
group=product_full&sku=SCM10CD ($49.99)

o Uninstaller: http://macmagna.free.fr/Uninstaller/ ($29)

When you finish deleting files, don’t forget to empty your Trash
(choose Finder > Empty Trash or press Command-Shift-Delete). Until

you do so, your Mac won'’t free up the disk space previously occupied
by the files.

CHECK LOG FILES

Many of the programs on your Mac continually record details about
what they’re doing in log files. In particular, they tend to make log
entries when they encounter errors or other unexpected situations.
In addition, every time an application crashes, a system-wide process
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called CrashReporter records the details of that crash in its own log.
Log files are therefore an excellent source of information about what
might be causing whatever problem you’re experiencing.

Log files tend to contain a lot of highly technical data that looks

like gibberish to the uninitiated. This data is useful to programmers,
though, and if you contact a company’s technical support department
to report a bug, they may ask you to send them one of your log files
to help determine what the problem was. However, even without
understanding all the ins and outs of a program’s workings, taking

a quick glance at its log files can sometimes give you hints you need
to track down a problem.

The easiest way to view log files is with a program in /Applications/
Utilities/ called Console. (It could just as easily be called “Log
Viewer”—all it does is display logs.) When you open it, it displays
one or more windows like the one shown in Figure 5. On the left,
the window lists logs you can view; if this list isn’t showing, click the
Show Log List button (labeled Logs in Tiger) in the toolbar.
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Figure 5: It's not pretty, but Console can help you figure out why
something went wrong by showing the log files applications create.

Console can show two particularly important log files: console.log

and system.log. These two log files tend to contain the most interesting
error messages generated by applications and Mac OS X itself. Some
items may appear in just one of these logs or the other; some appear in
both. But while system.log shows only messages generated since your
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last restart, console.log keeps a longer record. To display the contents
of system.log, select it in the Log List on the left. To display the con-
tents of console.log, choose File > Open Console Log or, in Tiger, select
console.log in the Log List.

So you’ve opened one of these logs, and you’re thinking: “I don’t have
a clue what I'm looking at or how to find what I'm looking for.” It may
take time and experience to get a feel for what’s truly helpful and what
to do when you find it, but here are some tips to help you glean useful
information:

« Start at the end: The most recent information is at the bottom,
and it’s updated in real time. So if you've just experienced a crash
or other problem, information about it is likely to be near the bot-
tom of one of the logs.

« Filter: You can filter a log to display only the lines containing some
string of text by typing in the Filter field in the toolbar. For example,
if you type in error, Console displays only those lines with the word
“error” in them somewhere. (And that is, in fact, a highly useful
place to start. Another useful term to filter for is fail.)

« Repetition is significant. Repetition is significant: Pay
special attention to lines that repeat many times. If you see the
same (or similar) error message 50 times in a row, you know that an
application is repeatedly trying and failing at some task. At the same
time, some applications are simply chatty and fill logs with lots of
messages that don’t indicate any problems.

« Consult the oracle: If you see a phrase that suggests a problem
but you don’t know what it means, try searching for it in Google,
enclosed in quotation marks. For example, suppose you have a
log entry that reads:

Apr 25 19:19:03 MacBook-Pro /Library/PreferencePanes/
BusySync.prefPane/Contents/Resources/BusySync.app/Contents/
MacO0S/BusySync[411]: Warning: accessing obsolete X509Anchors.

You might try searching Google for "Warning: accessing obsolete
X509Anchors" (again, remember the quotation marks), which may
list developer documentation on what that phrase means or reports
from other people who have seen that message in their logs and
have theories as to its significance.
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« Go back further: You can also look at older copies of system.log
by navigating in the Logs list to /var/log.

« Cast a wider net: Although console.log and system.log are the two
most useful log files, they don’t contain every log entry. Also look in
other places in the Logs list, such as /Library/Logs and ~/Library/
Logs, for logs specific to a program. In addition, check in /Library/
Logs/CrashReporter and ~/Library/Logs/CrashReporter for an
application’s crash logs.

CLEAR CACHES

Caches help applications load more quickly and run more efficiently
by storing frequently used information. Usually, caches speed up your
computer and are therefore good to keep around. However, in certain
situations, a cache can cause problems rather than solving them. If

a cache file becomes damaged, for example, an application may crash
or otherwise misbehave when it reads in that file. Or, if a cache file
grows excessively large, it may take longer to read it than it did to
generate it in the first place.

Note: I discuss caches in some detail in a Macworld article titled
“34 Software Speedups” (http://www.macworld.com/2006/02/
features/softwarespeed/).

Most of your caches live in one of two places: /Library/Caches or
~/Library/Caches. Any of these files can be deleted safely, because
applications regenerate cache files automatically as needed. However, I
recommend against wiping out caches indiscriminately, because intact
caches (which will be most of them) do improve your computer’s
performance.

When a troubleshooting procedure calls for clearing caches, follow
these steps:

1. Make sure the application you're troubleshooting is not running.

2. Look for a file or folder containing the name of the offending
application—look first in ~/Library/Caches and then in /Library/
Caches. If you find it, drag it to the Trash. (In some cases, you may
have to enter your administrator password when dragging cached
files to the Trash.)
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3. Reopen the application and see if the problem still exists. If not,
you're done. If it does, continue with...

4. If you're having trouble with a Microsoft Office application,
consider deleting its font cache, which is stored separately from
other caches:

« For Office 2004 or earlier, drag the file ~/Library/Preferences/
Microsoft/0Office Font Cache (11) to the Trash. (The number
in parentheses may be different depending on which version of
Office you’re using.)

« For Office 2008, the file is ~/Library/Preferences/Microsoft/
Office 2008/0ffice Font Cache (12).

Test to see if the problem has disappeared. If not...

5. Tiger and earlier versions of Mac OS X (but not Leopard or later)
maintain a system-level font cache that numerous applications use.
Bad font cache files have been implicated in numerous problems.
To clear your font caches, drag the folder /Library/Caches/
com.Apple.ATS to the Trash. Enter your administrator password
when prompted, and click OK. Then restart your computer and
empty your Trash. If the problem still hasn’t gone away...

6. Delete your other system-wide caches—everything else in /Library/
Caches—and restart your computer. Test once again to see if the
problem is gone. If not...

7. As a last resort, delete the caches in /System/Library/Caches. (You
will again need to enter your administrator password to do so.)
Restart your computer.
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Cache-Clearing Utilities

Because dragging a folder to the Trash is easy and lets me control
exactly what gets deleted, I prefer to clear my caches manually.
However, numerous utilities, including the following, enable you to
clear caches with just a couple of clicks (in most cases letting you
choose which caches, and also letting you delete logs and other
clutter at the same time):

o Cocktail: http://www.maintain.se/cocktail/ ($14.95)

e Leopard Cache Cleaner: http://www.northernsoftworks.com/
leopardcachecleaner.html ($9.99)

e MacCleanse: http://koingosw.com/products/maccleanse.php
($19.95)

e MacDust: http://www.macdust.com/ ($9.95)
e OnyX: http://www.titanium.free.fr/pgs/english.html (free)

e Yasu (Yet Another System Utility):
http://jimmitchelldesign.com/projects/yasu/ (free)

CHECK YOUR RAM

Mac OS X is picky about the quality of RAM in your computer. If it’s
defective or even slightly out of spec, kernel panics or other crashes
can result. RAM installed by Apple at the factory has a low incidence of
failure, but if you’ve installed third-party RAM yourself (and especially
if you used a cheaper brand), you're at a greater risk for problems.

Several utilities can check your RAM to make sure it’s healthy:

« Apple Hardware Test: This one is not only free, it also came
with your Mac (if you purchased it within the past several years).
Depending on when you bought your computer, it could be on an
independent disc, or it may be included on the Mac OS X Install
Disc. (Look for tiny lettering on the disc that says “T'o use Apple
Hardware Test, hold down the Option key as the computer starts
up,” or words to that effect—the key you're asked to press varies.)

« TechTool Pro: http://www.micromat.com/index.php?option=
com_ content&task=view&id=202&Itemid=107 ($106)

« Rember: http://www.kelleycomputing.net:16080/rember/ (free)
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If you use a third-party tool, follow the instructions that came with
it. To run Apple Hardware Test, follow these steps:

1. Insert the disc with Apple Hardware Test on it into your Mac and
restart, holding down the Option key until icons appear represent-
ing the available startup volumes.

Apple knows best: If the disc label specifies holding down a key
other than Option, do what the label says.

N

Click the Apple Hardware Test icon, and then click the right arrow.
After the program loads, select a language and click the right arrow.

On the Hardware Tests tab, click Extended Test.

A

Catch up on your gardening or read the newspaper—this test can be
time-consuming!

The screen may say something like “Estimated time: 10—15 minutes,
or longer depending on the amount of memory installed.” Take the
“or longer” part seriously. On a test machine with only 2 GB of
RAM, the test took almost an hour and 45 minutes.

6. If all is well, the word “Passed” appears next to all the applicable
tests in the Test Results area. If not, a failure message appears;
if this happens, look in the About the Test and Results area for
advice.

7. Click Restart to restart your computer.

If Apple Hardware Test (or another utility) reports that you have
defective RAM, the module in question must be replaced. If the
module was installed by Apple and your computer is still under
warranty (or AppleCare), Apple should replace it at no charge. If

you purchased your RAM from another vendor, check their warranty
terms. (Several RAM vendors offer lifetime warranties.)

TEST FOR REPRODUCIBILITY

You've heard the old joke: “I said, ‘Doctor, it hurts when I do this.” And
he said, ‘Then don’t do that.”” But, of course, any doctor truly would
want to know what makes a symptom worse (or better). If you can
clearly describe the circumstances under which some problem reliably
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occurs, you’ll be that much closer to a diagnosis. It’s not terribly help-
ful to know that your arm hurts “sometimes” or that Safari crashes
“now and then.” But if your arm hurts only when you hold it at a cer-
tain angle or Safari crashes only when you visit a certain Web site, then
you’re on to something.

When programmers debug code, they love to have detailed reports
about exactly how to reproduce a problem. If the programmers can
get the problem to occur, they can usually fix it. If they can’t, they have
to guess at what might be causing the problem. If you plan to report a
bug to a software developer, having information on reproducibility is
important. But even if you're just trying to work around it yourself,
knowing where and when the problem occurs can help you to isolate
the cause.

Testing for reproducibility isn’t as easy as it sounds, though, because
sometimes problems seem to occur randomly or unpredictably. But
you can get at least partway there with these suggestions:

« Take notes: When you encounter a problem, immediately think
about the two or three things you did most recently, and write them
down. For example, if Mail crashes, you might make a note of the
fact that you just checked your email, and before that you added a
new rule, and before that you did a search for messages from your
boss. If the problem happens repeatedly, these notes can help you
find patterns.

« Narrow the scope: Let’s say a problem occurs when you have
a dozen applications running. Try quitting half of them and see if
the problem still occurs. If it does, quit half of the ones remaining,
and so on. Or, if a problem happens when you’re running Mac OS X
normally, try a Safe Boot (see Start Up in Safe Mode). And if the
problem goes away, try rebooting normally but disabling login items
(see Turn Off Login Items). You're trying to get the problem to
occur under conditions as specific and repeatable as possible.

« Try other environments: If a problem occurs on your Mac,
does it also happen on your spouse’s Mac? If your mouse is jittery
when plugged into your keyboard’s USB port, is it also jittery when
plugged directly into the computer’s USB port? If a document looks
weird in Word, does it also look weird in TextEdit? Try to test
whether your problem appears under a variety of circumstances.
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If you can get to the point where you can get a problem to occur
intentionally—always and only when you’re trying to—you’re actually
close to a solution. If the obvious remedies (such as disabling prefer-
ence files and caches and starting up in Safe Mode) don’t work, you at
least have solid information to provide to the developer’s tech support
staff, which can help them to solve your problem.

GET SYSTEM INFORMATION

Many of the troubleshooting steps you may take (such as searching
for information on Apple’s Web site or contacting technical support)
require that you know exactly which version of Mac OS X you’re run-
ning, among other details. If you don’t know which version of Mac
OS X is installed, choose @& > About This Mac (Figure 6).

B0 About This Mac

Mac .05 X

version 10.5.6

" Software Update,.. |

Processor 2.4 CHz Intel Core 2 Duo
Memory & GB 667 MHz DDR2 SDRAM

Startup Disk Leapard

i i

More Info...
1983 -2008 Apple Inc

All Rights Reserved

e _________________________________________________ _J

Figure 6: Choose @ > About This Mac to display a window showing
your Mac model, operating system version, and other details.

When you're talking to a developer’s technical support staff, they may
ask you for more detailed information about your Mac, such as which
extensions are installed and what brand of hard drive it has. To get this
information, use an Apple utility called System Profiler.
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You can launch System Profiler either by clicking the More Info button
in the About This Mac window or by double-clicking System Profiler in
/Applications/Utilities. At this point, a technician may instruct you
to look for, and read off, certain information, or save a file with all the
details and send it in by email. To do this, as shown in Figure 7,
choose File > Save, type a name, choose a location, and leave File
Format set to System Profiler 4.0 (XML) unless instructed otherwise.
Click Save, and then attach that file to an email message.

~no dastcpic

Macioak Fro argsioa TS0 em |
S xort A [MRERGORERER & moates
¥ Hargwarg & | L1)3600R 13T AM . |
ATA o Whare: | (22 Desktop ] L1/25/08 243 AM
Ao (Buil n 11/25/08 339 P4 |
Bluetesth 11/25 708 Tbd AM
DHagrodEcs File Format | System Profiler 4.0 (XML ﬂ 12/ U7 I0E T35 Ak
[Hpe Burning L1/35.008 300 AM
Figre: Channed e 1125708 300 AM
Fareiiire [ Cancel | (FSava) 11/25 /08 301 AM
G phics fH s s 11/25,/08 300 AM
Herdwmare RAID  Enele AN g TEs 1125 /08 108 AM
Memary AppleAPic 1.4 LLIZ5I08 T4T AM
PC Cards AppleBacklight 1.4.13 1125708 307 AM
PCI Cards ADpeEFINVRAM 1.2.0 11/25/08 309 AM
Parallel 5C5 AppleEFIRuntime 120 1125 /08 .00 AM
Perwnr = ApplePWOHC Lr2 1125708 T 43 AM
Prinbers Applek DA 1.6.2 L1/25)08 250 AM
SA5 Appled DWConnroller 16.2 11/25708 251 AM |
Serial-ATA ApgleHPET 1.2 11/26/08 707 &AM | ¥
L5E =
e ACPI_SMC_PlatformPlugis: 1
AirPort Card Nl 151
Frewall Last Modfed:  11/26/08 1:27 Ak
Liscations Gat Infe §iring: ACH_TWC_MasformPlugin version 31,1, Copyright 2000-2008 Apple bng,
B g Location Fopsoem JLinrary Envensions [ROPLac e mPleagnFamiky e s iConpemaiFugins
ACR_SME MatfarmPluginkex
WORHTH kewt Wersion:  3.3,Td0
¥ Softere Lodd Addraids  OxTdeSedsd
Appications walid Yt
Exngadinad Authentic Yk LS
Fosts Depediencies:  Satisfed e
- Alegriy Eixf hid i fedgipl L
Framewnrzi L] |

Figure 7: You can save the entire System Profiler report about
your computer to send to a technical support representative.
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Solve Common Problems

Now that you have some basic problem-solving techniques under
your belt, it’s time to move on to some specific problems. I realize
that many problems you may encounter aren’t mentioned here (in
which case, move on to Troubleshoot Novel Problems), but these
are nine of the most common Mac problems for which there’s a
straightforward path to a solution.

YOUR COMPUTER WON'T TURN ON

One day you sit down at your Mac and press the power button, but
instead of the reassuring startup chime you hear nothing. No power
light, a blank screen—no sign of life. This is an especially good time
to remember not to panic. Take a deep breath and follow these steps:

1. Check the entire electrical path. Start with the power cord where it
connects to your Mac and make sure it’s firmly seated. Then make
sure the other end is plugged in tightly. If you have anything else
between the plug and the wall outlet—such as an outlet strip, surge
protector, or UPS—check each of the plugs along the chain. While
you’re at it, check for crimps or sharp angles in the cords, which
could mean broken wires inside. If you find or suspect a broken
wire, replace the cord. (Also keep in mind that if you were using
a surge protector and there was a lightning strike or power surge,
it may have sacrificed itself to protect your Mac. Be sure to check
its failure indicator.)

If all the connections look good, try plugging a lamp or other device
into the same outlet as your computer to verify that the juice is flow-
ing. If not, check your building’s circuit breakers. If it still won’t
turn on...

2. Unplug everything from the computer except the keyboard, mouse,
and display. Press the power key again. If it turns on, suspect a
faulty peripheral. If not...

3. Reset the computer’s PMU, SMU, or SMC (if appropriate). (See
Reset PMU, SMU, SMC, NVRAM, or PRAM for details.) Obviously,
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you can’t perform a procedure that requires you to hold down keys
while starting up if you can’t start up, but most of these resets can
be done without power.

If none of these procedures brings your Mac back to life, it’s time to
call a repairperson. See Go to the Source.

What If Your Computer Keeps Turning Itself Off?

Perhaps the problem isn’t that your Mac won’t turn on, but that it
keeps turning itself off when you don’t want it to. This could signal
a problem with your computer’s power supply or logic board. In
particular, some iMac G5 models had a manufacturing defect that
resulted in this symptom and required replacement of the defec-
tive parts (both my wife and I had models with this issue—and we
were extremely glad they were covered by AppleCare!).

However, before taking your computer in to the shop for a
potentially expensive repair, try the following:

e Check to see that the power cord is firmly seated (on both
ends), and if your computer is plugged into an outlet strip,
make sure that’s also plugged in securely.

e Carefully check the settings in the Energy Saver pane of
System Preferences. In particular, click the Schedule button
and verify that your computer is not set to shut down
automatically.

e Start Up in Safe Mode and run your computer for a while to see
if the problem recurs.

e Reset all the nonvolatile memory (see Reset PMU, SMU, SMC,
NVRAM, or PRAM).

If your Mac keeps shutting itself off (or restarting randomly), it’s
time to take it in for repair.

YOU EXPERIENCE REPEATED KERNEL
PANICS

When a single application crashes, it’s annoying but at least the rest of
Mac OS X usually continues to function. But occasionally, you may find
that your screen dims, your computer no longer responds to your
keyboard or mouse, and a message like the one in Figure 8 appears
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on your screen. What has happened is known as a kernel panic—a type
of low-level, system-wide crash that Mac OS X can’t recover from.

You need to restart your computer. Hold down the Power
button for several seconds or press the Restart button.

Veuillez redémarrer votre ordinateur. Maintenez la touche
de démarrage enfoncée pendant plusieurs secondes ou bien
appuyez sur le bouton de réinitialisation.

Sie mussen lhren Computer neu starten. Halten Sie dazu
die Einschalttaste einige Sekunden gedruckt oder driicken
Sie die Neustart=Taste.

AVE1—9%BENTIUELNBDET, NT—HRIy 0%
BB LBETAN, VEYRRY I ZBLTLEZN,

Figure 8: This mysterious-looking message means you’ve just had a
kernel panic. Follow the instructions, and then if it recurs, take steps
to solve the underlying cause.

A single isolated kernel panic is usually nothing to worry about. Follow
the instructions: hold down the power key to turn off your Mac, turn it
back on, and forget about it. However, if kernel panics happen often

(say, more than once per week), something more serious may be afoot.

Unlike application crashes, kernel panics tend to occur seemingly
randomly, making them difficult to reproduce. It doesn’t usually make
sense to try something, test whether the panic recurs, and then move
on to the next step. Instead, start by doing all these things:

Check your disk space: A kernel panic could be a sign that you're
running low on free disk space. If necessary, delete unneeded files
to free up extra space; see Check Free Disk Space for help.

Make sure your RAM is healthy: See Check Your RAM.
Repair disk permissions: See Repair Permissions.

Make sure your firmware is up to date: To see if Apple

has made a firmware update available for your computer, visit
http://www.apple.com/support/downloads/ and search for your
Mac model; or, for PowerPC-based Macs only, consult the table at
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http://support.apple.com/kb/HT1395. If an update is available,
follow the included instructions to apply it.

« Check for software updates: Any of the applications that were
running when the kernel panic occurred may have bugs that
resulted in the crash. Download and apply any available updates.

If you continue having kernel panics, try each of these steps in order:

1. Unplug peripherals: If you have anything plugged into your Mac
other than a keyboard, mouse, display, and Ethernet cable, unplug
it. That includes any printers, scanners, PDAs, cameras, or other
USB or FireWire devices. (If you have a spare keyboard and mouse,
you might try those, too, since they could be part of the problem.)
Restart, and see if the kernel panic recurs. If not, add the devices
back one at a time:

« Ifyou find the one that causes the crash, check that you’re using
the latest driver software, and if so, contact the manufacturer for
assistance.

« If the panics continue with all devices unplugged, move on to...

2. Check kernel extensions: Look in /System/Library/Extensions
for any third-party items you may have added recently. This may
include things like drivers for audio interfaces and input devices,
encryption and security software, and certain system enhance-
ments. Drag any such files to the Trash (entering your password
when requested).

Warning! Most of these files are essential to the functioning of
Mac OS X, so don’t remove any files unless you're certain they
were added by software you recently installed.

Restart and see if the problem goes away. If it does, reinstall the pro-
grams that use the kernel extensions one at a time, restarting after
each one, until you find the culprit. If panics continue, move on to...

3. Try a Safe Boot: Read Start Up in Safe Mode for instructions.

« Ifthe problem goes away, look in the folders inside /Library and
~/Library for files you’ve added recently. (To make this easier,
choose View > As List and then click the Date Modified column
to sort the folder’s contents by how recently they were changed.)
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Move them out temporarily, restart normally, and try again until
you’ve narrowed down the cause.

« If you cannot narrow down the cause, go to...

4. Disable your login items: Perform the steps in Turn Off Login
Items. If the panics disappear, open the Accounts pane of System
Preferences, go to the Login Items view, and remove the items in
that list (starting at the end) one by one, logging out and back in
after each one. Stop when you’ve identified the problematic item.

If, after you've done all these things, the kernel panics continue, your
only recourse may be to reinstall Mac OS X. See the sidebar “A Clean
Start,” next, for specific advice.

A Clean Start

Reinstalling Mac OS X isn’t the quickest or easiest troubleshooting
step, but it needn’t be painful either—as long as you do it the right
way. When the time comes to reinstall, follow this procedure:

1. Be sure you have a good bootable backup.
2. Using your Mac OS X Install CD or DVD, run the installer.

3. On the screen that asks you to choose a destination, select
your startup volume and then click the Options button.

4. Choose the Archive and Install method, which keeps your
existing applications and numerous other files in place; be sure
to select Preserve Users and Network Settings too; otherwise
you’ll face the tedious task of manually restoring all your files
and preferences.

5. Proceed with the installation, and restart your Mac when it
finishes.

6. Manually recover any files you need that weren't preserved
in their original locations by copying them from the folder
/Previous Systems/Previous System 1 or from your backup.

In the highly unlikely event that even this step doesn’t solve

your problem, you must truly start from scratch with another
reinstallation of Mac OS X, this time choosing the Erase and Install
method. Then reinstall your applications manually and restore
your personal files from your backup.
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YOUR MAC IS ABNORMALLY SLOW

A single application running slowly is annoying, but when your entire
Mac slows down, getting even simple tasks done can be an exercise in
frustration. You can use any of numerous tactics to return your Mac to
its usual peppy state.

Before getting into specific steps, I want to point out that many of us
find our Macs become slower over time, and the biggest reason is that
the amount of overhead they have to manage increases. By “overhead,”
I mean the little background programs, application enhancements,
utilities, menu extras, and—to use a highly technical term—doohickeys
that we Mac users tend to accumulate. Each one may increase produc-
tivity or convenience in some way, but if you get enough of them, they
can weigh down your processor.

Also contributing to overhead are extra applications that you may be
running but not actively using, plug-ins for a Web browser or email
program and even highly important tools like backup programs. So
speeding up your Mac is largely a matter of paring your doohickeys
back to those that are most essential, while taking note of programs
that are improperly consuming more than their fair share of your
computer’s resources.

When your Mac is running slowly, follow these steps until the speed
returns to normal:

1. Restart: After you do so, you may find that your Mac runs more
slowly the longer you use it. If so, continue with one or more of
the following steps.

2. Quit applications you aren’t actively using: You may want
to keep some programs, like your email client, open all day. But
anything that’s running in the background can drag your CPU
down. Web browsers—and Safari in particular—are notorious for
doing this, especially when you have Web pages open that feature
sound, animation, movies, or other elements that require a lot of
processing. Keeping many tabs open will just make this worse.

3. Look for rogue background processes: Read Use Activity
Monitor for instructions. Look for items that use a lot of CPU or
RAM but provide little or no benefit, and quit them. Be aware that
Spotlight’s indexing processes (mds and mdimport) sometimes hog
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a lot of CPU cycles for a while and then turn themselves off. But if
they’re causing problems, you can safely quit them. Then...

Out of the Spotlight

Spotlight’s indexing can slow down your Mac even when it’s
working correctly; if you have folders that contain lots of fre-
guently changing files that you don’t want indexed, add them
to the privacy view in the Spotlight preference pane.

4. Prune login items: Once you've quit some background
applications, you need to make sure they don’t run automatically
the next time you log in. To do this, open the Accounts pane of
System Preferences. Go to the Login Items view and locate any
items in the list you can afford not to have open when you log in.
Select each one and click the | - button.

Keeping it simple: Several other mechanisms exist to launch

background processes, but for the sake of simplicity, I'm omitting
them. Suffice it to say that if an application includes a problematic
background process, uninstalling that entire application is usually
the best and most reliable solution.

5. Disable other unneeded doohickeys: Although you could
do this manually, I suggest downloading Stéphane Sudre’s free
preference pane Diablotin, which lets you disable (and enable)
system add-ons such as contextual menu items, Internet plug-ins,
menu extras, and startup items simply by checking or unchecking
boxes (http://s.sudre.free.fr/Software/Diablotin.html). Be aware,
particularly with startup items, that some programs won’t work
properly if their associated background process isn’t running. After
disabling doohickeys, be sure to restart your computer.

6. Look for other processing burdens: Some plug-ins may slow
your Mac. For Web-browser plug-ins, look in /Library/Internet
Plug-Ins and ~/Library/Plug-Ins. For Mail plug-ins, look in
/Library/Mail/Bundles and ~/Library/Mail/Bundles. Any of
these items you’re sure you don’t need can go in the Trash. Or at
least, move them somewhere else temporarily to see how much your
Mac’s speed improves. If you have backup software running, see if
you can set it to run only during times your Mac is usually idle.
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7. Check for PowerPC applications on Intel-based Macs: If
you have an Intel-based Mac and you’re still running applications
written for the PowerPC processor, those programs can cause slow-
downs. Not only will they run slower than programs written for
Intel-based Macs, but they can slow down other things too.

To tell which PowerPC applications are running, open Activity
Monitor. Resize the window so it’s wider than normal, and choose
View > Columns > Kind to display a column with the type of code
each application is running. If any application says “PowerPC”
(instead of “Intel”), check to see if an Intel-native (or “Universal”)
update is available for that program.

8. Run a disk-repair utility: Directory damage or other disk errors
can slow down your Mac. Using a disk utility (see Run Disk-Repair
Utilities) usually fixes them.

Fragged: In a few cases, such as when you use audio or video
recording software heavily, or when your disk has recently been
very full, defragmenting your hard disk can lead to speed
improvements. Among the several utilities that can defragment
drives on both PowerPC- and Intel-based Macs are Micromat’s
TechTool Pro, Prosoft’s Drive Genius, and Macware’s DiskTools
Pro (any of which may be the very utility you ran in Step 8).

9. Add RAM: If your computer doesn’t already contain its maximum
amount of RAM, consider adding more. Most new Macs come stan-
dard with 1—2 GB of RAM, and for users with very basic needs that’s
often adequate, but adding even another gigabyte or two can have a
huge impact in performance. This is even more true for people with
older Macs that included less RAM to begin with.

If you've done all these things and still find your Mac is slow, you may
want to consider whether it’s time for a newer model. Recent versions
of Mac OS X and major applications take a lot of CPU power to run at
an acceptable speed; if you're still using a PowerPC processor or one
of the early, less-powerful Intel processors, it may simply not be up to
your tasks.
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YOU CAN'T EMPTY THE TRASH

Once in a while, you may choose Finder > Empty Trash and get an
error message saying a file can’t be deleted. The error message may
give several reasons for this, such as the file being in use, being locked,
or having permissions that prevent you from deleting it:

« If the error message states that the file is in use, restart and try
deleting it again.

« If the error message states that the file is locked, hold down the
Option key while choosing Finder > Empty Trash.

« If the error message states that you do not have permission to delete
a file, or if you see no error message at all but the file won’t go away,
follow these steps:

1. Open Terminal (in /Applications/Utilities).
2. Type this, and then press Return:

cd ~/Trash
3. Type the following:

sudo rm -R

followed by a space (the space is very important).

4. Open the Trash window, select everything inside it, and drag
those selected items into the Terminal window.

5. Press Return.
6. Enter your administrator password when prompted.

You can download numerous utilities that can force the Trash to
empty, but in my opinion, this procedure is sufficiently simple that
nearly anyone can do it—and it requires no extra software.

AN APPLICATION GRINDS TO A HALT

At some point you’ve undoubtedly seen your mouse pointer turn into
this: @®. Apple calls it the “spinning wait cursor,” but most Mac power
users I know refer to it as the SPOD—the initials stand for “spinning

61



pizza of death,” “spinning pinwheel of doom,” or any of several other
clever variants—or the spinning beach ball pointer. It indicates that

an application has become unresponsive for more than a few seconds.
Most of the time, other software continues to function correctly, and
your pointer appears as a SPOD only when it’s over one of the windows
of the application that’s busy (or another of its elements, such as its
menu bar or Dock icon).

Applications can stop responding temporarily for many different
reasons. Sometimes, for example, they’re working hard at a task and
don’t even take a breath, as it were, for a considerable period of time.
Or, you could be running low on free RAM, slowing your applications
as they lean more heavily on virtual memory. An application could
also, of course, have a bug that causes it to hang. Whatever the reason,
the SPOD is annoying because it means you can’t do anything with that
application until it goes away.

When you encounter the SPOD, follow these steps:

1. Wait: More often than not, the SPOD goes away on its own—
after a few seconds or, occasionally, as long as a few minutes. If
the problem resolves itself and doesn’t return, you don’t need to
do anything else.

2. Quit other applications: If you have many applications open
at once, they can use up such a large proportion of your Mac’s
memory and CPU cycles that the application you're actively using
doesn’t have enough breathing room. So quit applications you aren’t
actively using, or at least close extra windows (including open win-
dows in the Finder) to free up extra resources. To see applications
and background programs that don’t show in the Dock, Use Activity
Monitor.

3. Force-quit: After 5 minutes or so of waiting—especially if you've
quit as many other applications and closed as many windows as you
can—you can be fairly confident that the program with the SPOD
isn’t going to come back to life. Your best bet is to force-quit it; see
Force-Quit an Application for details. (Note that in so doing, you’ll
lose any unsaved work, but you may not have any choice.)

4. Restart: As I've said elsewhere in this book, restarting clears up
a lot of common complaints. If a relaunched application hangs
again, try restarting (see Restart Your Mac).
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5. Check your disk space: If an application continues to run slowly
even after your restart, make sure you’re not running low on free
disk space. Learn more in Check Free Disk Space.

6. See if you have a damaged preference file: For instructions,
read Check Preference Files.

7. Check for software updates: If the application was running
slowly due to a bug, it may have been fixed in a more recent version.
Download and apply any available updates.

8. Contact the developer: When none of these steps solves the
problem, contact the developer’s technical support department.
They may know what the problem is, or be able to suggest more
concrete next steps.

Try More RAM

If you run lots of software at once, or if you run just one or two
programs with voracious RAM appetites (I'm thinking of software
such as Photoshop and Final Cut Pro), you will likely find that your
computer runs rather slowly if it has only 512 MB or 1 GB of RAM.

Depending on your computer’s RAM capacity and your budget, I
recommend having at least 2-4 GB of RAM. More is even better,
up to a point—unless you're doing extremely high-end video or

graphics work, you’ll probably find that the cost-to-benefit ratio

of more RAM becomes excessive after about 8 GB. (However, in
some cases it may be most economical to install a bit more—for
example, adding 8 GB to a Mac Pro that already has 2 GB—and

more certainly won't hurt.)
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Looking for Signs of Life

When an application stops responding, it could be because

Mac OS X itself has seized up. When this happens, you’ll be unable
to switch to other applications (even to quit them), force-quitting
may not work, and you may even lose keyboard and mouse con-
trol; performing a brute-force restart with the power button is
usually the only cure. However, those symptoms could also mean
than that an application is monopolizing your processor
temporarily. How can you tell the difference?

The key is to take steps before your computer hangs to provide
clues as to its activity level. You can do this in either of two ways
(but I do both, for extra information):

e Open the Date & Time pane of System Preferences. In the
Clock view, make sure Digital is selected, and check the Display
the Time with Seconds box.

Later, if a freeze occurs, look at the clock in your menu bar.

If the seconds display doesn’t change—and remains stuck for
more than a minute or two—your computer is unlikely to return
to operation on its own. Restart it manually.

e Download the free MenuMeters utility from Raging Menace
(http://www.ragingmenace.com/software/menumeters/) and
install its included preference pane. In the CPU view of this
pane, check the Display CPU Menu Meter box and choose
a style for your CPU meter (my favorite is Percentage and
Thermometer, which looks something like this in your menu
bar: #%% ﬂ; if your computer has more than one processor or
core, each one gets its own meter).

When your Mac appears to hang, check the CPU meter. If the
value changes over a period of a minute or two, your Mac is
simply busy, so I suggest continuing to wait for a while. If it’s
stuck—especially at something less than 100%—for more than
a few minutes, restart your Mac manually.
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AN APPLICATION CRASHES

When an application crashes in Mac OS X, it usually disappears
without warning. A few seconds later, a dialog like the one shown in
Figure 9 appears.” Translation: Something went wrong. We don’t
know what. You can launch the application again and keep your fingers
crossed that it won’t happen again.

The application BombApp quit unexpectedly.

Mac 05 X and other applications are not affected.

Click Relaunch to launch the application again. Click
Report to see more details or send a report to Apple.

lgnore (" Report... 5'" " Relaunch

Figure 9: The first time an application crashes, a dialog like this
usually appears. Click Relaunch to launch it again.

When an application crashes, try each of these steps in sequence until
the application runs without crashing:

1. Click Relaunch (or, in some versions of Mac OS X, click
Reopen): Often, clicking this button is all you need to do and your
application works properly from then on.

If you were to click the Report button instead, you could send a
report to Apple with details about what went wrong. But chances
are slim that you’ll be the only one to report this problem, and that
your report alone will enable Apple to solve it. (Moreover, the only
problems Apple is likely to be able to solve are those that occur in
Apple applications; the Report button doesn’t send any information
to third-party developers.) Even if that happens, though, an update
may not appear for a long time. My advice: unless this problem

2 A few applications, notably Microsoft Office, have their own mechanisms for
reopening after crashes and may not display this dialog. If you experience a crash
without this type of dialog, move on directly to Step 2.
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recurs several times, don’t bother clicking Report.3 You want to get
back to work right now, not hold out hope for a solution months in
the future.

Try, try again? If the application crashes again after clicking
Relaunch (or Reopen), you can keep trying, but your chances of
success are slim. Some versions of Mac OS X give you the option

to reset the application’s preference file after your second relaunch
attempt, but because this feature doesn’t work consistently, it’s
better to do this manually, as described in the next step.

. Check your preferences: Sometimes a damaged preference

file can result in an application crash. So follow the procedures in
Check Preference Files, earlier, to check or reset the application’s
preferences. If you rule out a bad preference file as the cause of the
misbehavior, continue with the next step.

. Restart: As usual, restarting often cures what ails your Mac. Be
sure to launch the application in question right after you restart
and check to see if it runs correctly.

. Try another document: Sometimes a damaged document can
cause an application to crash. To check this, open a different docu-
ment than the one you were working on, or create a new one.

. Update your software: Make sure you're running the latest
version of the software that’s crashing. The developer may have
fixed the bug that caused your problem.

. Repair disk permissions: Still no luck? Repairing disk per-
missions is worth a try, particularly if the application in question
is from Apple. See Repair Permissions.

. Log in as a different user: Log out (choose @ > Log Out User-
Name) and log back in again using your test user account (see Set

3 A number of applications (listed at http://smartcrashreports.com/list/) option-
ally make use of Unsanity’s Smart Crash Reports. This software modifies the crash
reporting procedure in supported applications so that crashes are reported not
only to Apple but also to the application’s developer. In such cases, clicking the
Report button is much more likely to result in a bug getting fixed promptly.
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10.

11.

12.

13.

Up Another User Account). If the application no longer crashes, it
means something in your home folder was causing the problem.

Back in your regular account, look through the folders in ~/Library
(especially in ~/Library/Application Support) and in the Login
Items view of the Accounts System Preferences pane and remove
any files you may have added or updated recently. One of those is
very likely the culprit.

. Try a Safe Boot: See Start Up in Safe Mode for details. If

rebooting in Safe Mode solves the problem, you know that some
system-level program is at fault. Look through the folders in
/Library, particularly the Extensions and StartupItems folders,
for anything that’s been added recently. Also look in
/System/Library/Extensions for any third-party . kext files that
have been added recently. Move any suspicious files to your
Desktop, restart normally, and try again.

Run a disk-repair utility: See Run Disk-Repair Utilities. All
sorts of random disk errors can lead to application crashes.

Reinstall the software: If the application still crashes, delete
it completely—including its preference file and any components
it may have placed in /Library/Application Support or ~/Library/
Application Support. Then reinstall it from the original disc or a
new download. After doing so, check for, and install, any available
updates to the newly reinstalled software.

Check your logs: If you've gotten this far and the application is
still crashing, be sure to look at your logs for clues (see Check Log
Files). If they don’t point to any causes you can discern, contact the
developer’s technical support department.

Check your backup: Try restarting from your bootable duplicate
and running the application. If it works correctly, consider cloning
your backup disk back onto your startup disk. If your latest backup
wasn’t extremely recent, you may need to exercise caution to avoid
overwriting newer files that you still want to keep. But this is still
faster and easier than the final option...

Reinstall Mac OS X: This is the most extreme step, but when all
else has failed, that’s what you need to do. See the sidebar A Clean
Start, earlier, for more details.
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THE KEYBOARD OR MOUSE DOESN'T WORK

Few Mac problems are more frustrating than an unresponsive input
device, because it can prevent you from performing the usual trouble-
shooting tricks you’d normally use! If your keyboard or mouse stops
working—or if your mouse pointer moves but clicks don’t register—you
can typically resolve the problem in one of several ways.

Wired Devices

If your input device is connected via a USB cable (look for a USB
symbol—shown at left—on the cable or next to the port on the
computer), follow these steps:

1. Unplug the device, wait 10 seconds, and plug it in. If it still doesn’t
work...

2. Plug it into a different USB port (preferably one built into the
computer itself, rather than a keyboard or hub).

Everybody needs a hub: If your input device is normally
plugged into a hub, and Step 2 resolves the problem, the hub could
be at fault. If it has a power adapter, make sure it’s plugged in
securely (on both ends). Try unplugging the hub from both the
computer and AC power and reattaching it, then reattaching your
input device to the hub. If it still doesn’t work, suspect the hub.

If moving the device to a different USB port doesn’t bring it back
to life...

3. Restart. Noticing a trend here? Restarting cures many ills. (And
remember, as discussed in Restart Your Mac, you can do so using
the keyboard alone if your mouse isn’t working, and using the
power switch alone if neither keyboard nor mouse is working.)

A mouse of a different color? If you're using a third-party
input device that comes with its own software (I'm thinking of
brands like Kensington, Logitech, and Microsoft), or if you're using
a utility to modify your input device’s behavior (such as USB
Overdrive), and if nothing else has worked so far, this is a good
time to check for an update to your mouse or keyboard software.

If it still doesn’t work...
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. Unplug any other USB peripherals that may be connected, and

restart again. If it still shows no sign of life...

. If possible, verify that the input device works on another computer.

If it doesn’t, the device may be broken; contact the input device
manufacturer for assistance. If the device appears to be functional...

. If you have a spare input device, plug it in and use it. If even that

doesn’t work, your Mac may require service (see Go to the Source).

Bluetooth Devices

If your Bluetooth mouse or keyboard isn’t responding, follow these
steps:

1.

Make sure the device is turned on. For good measure, turn it off and
back on again—if it’s somehow stuck, this may unstick it.

. Temporarily turn off any other Bluetooth devices within a 10-meter

radius; they could be causing interference.

. Check your Bluetooth adapter, if any. This applies only if you're

using an external USB dongle for Bluetooth. Unplug it and plug

it back in. Try the input device again. If that doesn’t work, move

it to a different USB port and try again. (Be aware that moving the
adapter to a different port may require re-pairing; see Step 5.)

. Check your device’s batteries. If the battery level is low, or if you're

not sure, recharge or replace the batteries.

. Re-pair the device. Choose Set Up Bluetooth Device from the

Bluetooth (#) menu and follow the prompts. (If that menu isn’t

in your menu bar, open the Bluetooth pane of System Preferences
and check the Show Bluetooth Status in the Menu Bar box. Prior
to Leopard, this checkbox is in the Settings view.)

. If possible, verify that the input device works on another computer.

If it doesn’t, the device may be broken; contact the input device
manufacturer for assistance. If the device appears to be functional,
move on to the last step.

If you have a spare USB input device, plug it in and use it. Then visit
or call a repair facility for assistance (see Go to the Source).
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YOU LOSE YOUR INTERNET CONNECTION

Not so long ago, connecting to the Internet was a special activity that
most of us did on occasion by using a modem and a dial-up account.
Nowadays, although dial-up access has its place, most Mac users have
a high-speed, always-on connection of one sort or another—typically
via DSL, a cable modem, or a satellite link. And an increasing number
of applications, from search tools to backup software, assume that your
Internet connection is always available. So if your connection suddenly
goes down, getting even basic work done may be difficult—and some
applications may refuse to run at all.

If you're setting up a new DSL, cable modem, or satellite connection,
your Internet service provider is the best source of help. And, if you've
just installed a new router or AirPort base station, look at the included
instructions for troubleshooting tips. But if your connection was work-
ing fine, and it disappears without your having done anything different,
follow these steps:

1. Check your Web browser: If you notice an Internet outage
while in a Web browser, try a different one. (Safari, for example,
may lose its connection even though other browsers work well.)
And if you notice it in an email client or other program, open a
browser. Try visiting a few Web sites that are normally reliable
(such as http://www.apple.com/, http://www.google.com/, and
http://www.amazon.com/).

If some sites respond but not others, it could indicate a Web server
failure or a routing somewhere on the Internet—either one is likely
intermittent. If no sites respond in any browser, continue to...

Shortcut: If your browser displays a button that says Network
Diagnostics, click it and follow the prompts. Alternatively, in
Leopard or later, you can run the Network Diagnostics utility
manually by opening the Network pane of System Preferences,
clicking Assist Me, and then clicking Diagnostics. This tool
effectively automates Steps 2 and 3, which you can then skip.

2. Check your Ethernet or AirPort connection:

« If your computer connects to a router, switch, or modem using
Ethernet, check the cable connections at both ends; you could
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even try a different cable if you have one. If the cable appears
to be working, move on to Step 3.

« If you connect to the Internet wirelessly, make sure the connec-
tion is still active by checking the AirPort menu in your menu
bar. (If that menu is absent, open the Network pane of System
Preferences and check the Show AirPort Status in Menu Bar
checkbox.) Verify that you're using a network for which you have
access privileges, and that the Signal Level is consistently above
one bar. If that checks out, move on to...

3. Check for a self-assigned IP address: If your Mac uses
dynamic IP addressing (as many do) and it’s unable to get an
IP address from your router or your ISP, it will assign itself an
address beginning with 169.254. When that happens, you won’t
be able to connect to any computers outside your local network.

To check, open the Network pane of System Preferences and, in
versions of Mac OS X prior to Leopard, choose your current connec-
tion from the Show pop-up menu (in Leopard and later your current
connection should be pre-selected at the left). Then:

« Ifthe IP address begins with 169.254, it’s self-assigned:

o In Leopard or later, click Advanced, click TCP/IP, and then
click the Renew DHCP Lease button.

o In versions of Mac OS X prior to Leopard, click the Renew
DHCP Lease button in the main portion of the Network
preference pane.

Then wait a few seconds. If you get a new, router-assigned IP
address, check your browser to make sure your connection is live
again.

« Ifyour IP address isn’t self-assigned, or if trying to get a new
address doesn’t help, your next step is to...

4. Reset your router or base station: Whatever equipment is
between your computer and your outside Internet connection—
which may include your DSL or cable modem, AirPort base station
or third-party wireless access point, or other routers, or switches—
should be reset. Power it off (or, if it has no power switch, unplug
it). Wait 10 seconds, and power it back on. If you have more than
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one such device, do this for all of them, powering them back on
in order of closeness to the Internet (the cable modem, then your
AirPort Extreme Base Station, then your Ethernet switch, etc.).
Make sure each device has booted completely before powering
up the next one. Once everything has reconnected, try accessing
a Web page again. If you still can’t, go to...

. Restart your computer: After restarting, check a Web site or two
to confirm that your connection is restored. If not, continue with...

. Try another computer: If you have more than one computer
using the same Internet connection, see if another computer can
connect. If not, skip the next two steps and contact your ISP for
help. But if the other computer can connect, your Internet
connection itself is working, so proceed to...

. Check your DNS settings: Sometimes your Internet Service
Provider doesn’t specify the addresses for DNS (Domain Name
System) servers, instead supplying them to your computer dynami-
cally. If their default DNS servers aren’t responding for any reason—
or if the addresses for those servers don’t get through to your Mac—
you might not be able to reach any other computers on the Internet.

You can test if your DNS settings are causing problems by entering
the IP address for a Web site in your browser. For example, enter
http://17.112.152.32 to go to www.apple.com:

« Ifyou get an error message, proceed to the next step.

« If Apple’s Web page does appear, you know that DNS settings
are at fault. So open the Network pane of System Preferences.
In Leopard or later, select your current network connection in
the list on the left. Click Advanced and then click DNS. In Tiger
or earlier, choose your current connection from the Show pop-up
menu and then click TCP/IP.

In the DNS Server(s) field, you should have one or more IP
addresses entered. If not, and if your ISP supplied you with
addresses for their DNS servers, enter them now. Otherwise,
enter these two addresses (one on each line), which point your
computer to OpenDNS, a free DNS service: 208.67.222.220 and
208.67.222.222. Click OK (if applicable) and then Apply or
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Apply Now (depending on your version of Mac OS X) and try
connecting again. If that doesn’t work...

8. Try a ping test: When you ping another computer, you send it a
“packet”—a tiny message to say, essentially, “Is anyone there?” If
you get no response, it means either that computer isn’t functioning
or your Internet connection is dead; if you get a slow response, it
can mean hardware problems at your ISP (among other things).

To do a ping test, open Network Utility (in /Applications/
Utilities) and click on the Ping button at the top. Enter
17.112.152.32 (the IP address for www.apple.com) in the address
field, make sure Send Only 10 Pings is selected, and click Ping. You
should see a series of messages as shown in Figure 10.

ann Network Utilty.

' info  Metstat  AppleTalk Pin;u- Lookup  Traceroute ‘Whois  Finger  Port Scan |

Please enter the network address to ping

17.112.152.32 | e 10.0.2.1 o wer.ascample.com)

) Send an unkimited number of pings

® Send only 10 pings

Ping hos storted ...

PING 17.112.152.32 (17.112.152.32): 56 data bytes

B4 bytes From 17,102,158, 38 iomp_seq-R ttl=235 time=159.053 =5
B4 bytes From 17.112.152.33: iomp_seg=l Lt1=235 time=158.821 =5
B4 bytes From 17,132 152,32 iomp_sege? Etl=235 time=150.340 =ms
B4 bytes from 17,132 152.32: iomp_seged btl=235 time=159.454 ms
bytes From 17.112.157.32: iomp_seged ttl=235 time=-157. 458 m=
bytes From 17.112.15Z.32: iowmp_seg=5 ttl=235 time=-158.2331 ms
bytes From 17.102.15%2.32: 1omp seg-6 ttil=-235 time-1b1.HEZ ms
byted Freom 17.112.157.32: 1emp_seg=7 ttl=235 time=108.420 =3
bytes From 17.112.152.328: lomp_seq-% ttl=235 time=171.85% as
bytes From 17,102.153. 38 lomp_seq=9 t11=235 Lime=168,351 a5

TLZZET

= 17,112 152,32 ping statiskics ==
18 pockets btronsmitted, 19 pockets received, ¥ pocket loss
round-trip mindovg/mansstddey = 157 4587168, FAT/17] @58/3. 670 ms

—.
Figure 10: Using Network Utility’s ping feature can help you tell
whether your Internet connection is healthy, flaky, or nonexistent.

If all the packets sent were received (0% packet loss) and the whole
process took less than 30 seconds or so, then your Internet connection
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is working. If the summary line near the end says that none of the
packets was received (100% packet loss), your Internet connection is
down. If only some of the packets weren’t received, or if completion of
the test required several minutes or more, the slowdown is most likely
with your ISP or other Internet routing equipment.

If all these steps fail, contact your ISP for assistance.

PRINTING DOESN'T WORK

Printing is a hugely complex topic. Because printers fall into so many
categories, and can be connected in so many ways, lots of things can
cause printing problems. So I want to concentrate on a few of the most
likely causes and solutions to printing problems. In this section, I
assume that your printer was previously working fine with your Mac,
and that it has suddenly stopped printing entirely.

(If it prints, but the printout is distorted or otherwise incorrect—or if it
never printed in the first place—consult the documentation that came
with your printer and consider contacting the printer manufacturer’s
tech support. If you're seeing incorrect fonts on printed pages, consult
Sharon Zardetto’s Take Control of Font Problems in Leopard.)

When nothing comes out of your printer—not just one document, but
nothing from at least two different programs—follow these steps:

1. Make sure your printer is plugged in. While you’re at it, check the
cable connecting it to your computer (or your router or AirPort base
station), if it has one.

2. If your printer’s icon is already showing in the Dock, click it. If
not, then:

« In Leopard or later, open the Print & Fax pane of System
Preferences, select your printer on the left, and click Open Print
Queue.

« In Tiger or earlier, open Printer Setup Utility (in /Applications/
Utilities) and double-click your printer’s name to open the
printer’s window.

If there’s a button in that window’s toolbar labeled Resume Printer
or Start Jobs, click it. (Ordinarily, when the queue is running, it’s
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labeled Pause Printer or Stop Jobs.) Also, if there’s a job in the list
with a status of Hold, select it and click Resume. If nothing prints...

. Turn your printer off, wait a few seconds, and turn it back on. Try
printing. If that doesn’t work...

. If your printer is connected to a router, AirPort base station, or any
other intermediate device, turn off that device, wait a few seconds,
and turn it back on. Try printing. If that doesn’t work...

. In Leopard or later, go back to the Print & Fax pane of System
Preferences; or, in Tiger or earlier, go back to Printer Setup Utility.
Select your printer and click the | = | button (Leopard or later) or
Delete (Tiger or earlier). Then click | +  or Add and follow the
prompts to set it up again. Try printing. If that doesn’t work...

. If you have another Mac, see if you can print to this printer from
it. If you can, you know the problem is with your computer and not
your printer. So, double-check your cabling or other networking
connection to the printer and proceed to...

. Try Print Therapy (formerly called Printer Setup Repair). This
utility from Fixamac (http://www.fixamacsoftware.com/software/),
which you can try for free for 7 days, is available in versions for
each major revision of Mac OS X. (The price varies according to

the version of Mac OS X you'’re using—newer versions are more
expensive.) It can fix a wide range of printing problems. Follow the
included instructions; you can try each of several successively more
drastic repair procedures until you find one that works.

If none of these procedures gets your printer working again, contact
a consultant or repair shop for assistance (see Find a Consultant and
Go to the Source).
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Troubleshoot
Novel Problems

Sooner or later, you’re bound to encounter some problem you
haven’t experienced before, and which the previous section doesn’t
cover. Although I've seen hundreds of different things go wrong
with Macs over the years, I still run across novel problems all the
time. If the solution to some problem isn’t immediately obvious,

I go through a series of steps to narrow down the possible causes
and test remedies until I find one that works. That’s what I want

to teach you to do here.

First, I ask you to try some easy all-purpose solutions. But at a
certain point, you may need to look further for help. I describe
how to get more information and troubleshooting advice from
a number of different sources.

TRY THE STANDARD QUICK FIXES

If I get a headache, I generally take a couple of over-the-counter pain
relievers. If the headache goes away, I don’t worry about the cause; I
just get on with my day. Only if it doesn’t go away, or recurs, or accom-
panies other symptoms, will I call my doctor. Lots of Mac problems
fall into the same category. You can try any or all of several all-purpose
procedures that tend to zap lots of common irritations. If the problem
goes away, there’s no need to waste time tracking down its exact cause,
but if the quick fixes don’t work or the problem comes back, you can
move on to more detailed troubleshooting (see Ask the Right
Questions, two pages ahead).

Quick Fixes for Application Misbehavior

One of the most frequent Mac problems is an application that fails to
launch, refuses to open a certain document, has display problems, or
otherwise starts behaving erratically.
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If this happens to you, try each of these procedures in turn until the
problem disappears:

1. Quit and try again: If a program isn’t cooperating in any way,
quit it, reopen it, and then test to see if the problem is still there.

2. Force-quit the application: If the problem remains, or if the
application won’t quit normally, force-quit it and open it again
(see Force-Quit an Application). If it doesn’t work the first time,
it’s worth trying this procedure a few times in a row.

3. Restart: As always, restarting is a good way to zap numerous odd
problems. See Restart Your Mac.

4. Remove the preference file: If the application still misbehaves
after restarting, follow the procedure for checking or disabling its
preference file (see Check Preference Files) and launch it again.

5. Repair disk permissions: Although rare, it can happen that
incorrect file permissions prevent an application—particularly
one from Apple—from working correctly. See Repair Permissions.

6. Clear your caches: Focus on the cache for the application that’s
misbehaving. See Clear Caches.

If none of these ideas leads to a solution, skip ahead to Ask the Right
Questions, next page.

Quick Fixes for System-Wide Problems
Sometimes it’s not just a single application that’s misbehaving. If
your whole system appears to be slow or unresponsive, or otherwise
behaves in an unexpected way, try these fixes:

1. Close extra windows or applications: Sometimes applications
can chew up RAM and CPU cycles even if they’re running in the
background and seemingly doing nothing. Having many open win-
dows (even in the Finder) can also increase your RAM usage. Try
quitting applications or closing windows you’re not actively using.

2. Restart: See Restart Your Mac.

3. Check for free space: Be sure your disk isn’t close to being full.
Free up at least a couple of gigabytes. See Check Free Disk Space.
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10.

. Unplug peripherals: Hardware devices can sometimes cause odd

problems, as can the driver software that communicates with them.
Unplug any nonessential devices and see if the problem goes away.

. Repair disk permissions: If you've recently installed or updated

any software, it’s possible that the installer munged some essential
preference settings. See Repair Permissions.

. Run a disk-repair utility: At the very least, use Disk Utility’s

Repair Disk feature, which has been known to solve some weird
random problems. See Run Disk-Repair Utilities.

Clear your caches: Focus on system-wide caches (those found
in /Library/Caches). See Clear Caches for details.

. Disable unneeded doohickeys: As I described in Your Mac Is

Abnormally Slow, using Diablotin is an easy way to temporarily turn
off system enhancements that could cause problems with your Mac.

. Try your backup: If you have a bootable duplicate, start up your

computer from your backup volume (see Start Up from Another
Volume). If the problem goes away, you know that something

has changed since that backup occurred. One easy solution at this
point is to reverse the backup—duplicate your backup volume back
onto your regular startup volume. But in so doing, unless you're
very careful, you'll lose any changes made to your startup volume
since your last backup. If possible, therefore, make a second dupli-
cate of your startup volume—or at the very least make a backup
your home folder, which contains the files most likely to have
changed—so you can recover them after reversing your duplicate.

Reinstall Mac OS X: Although it sounds unpleasant, it’s not that
bad—and it can solve a lot of difficult problems that nothing else can.
For instructions, flip back to the sidebar A Clean Start.

ASK THE RIGHT QUESTIONS

If pain relievers haven’t cured my headache, I'd call my doctor, and
she’d probably ask me a series of predictable questions, such as these:
Have you hit your head recently? Have you had headaches like this
before? Do you have any history of brain injuries or disease? Do you
have any other symptoms, such as blurry vision or dizziness? The point
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of such questions is to identify the most likely (or most serious) causes
first. When your Mac has a problem that doesn’t respond to the easy
cures, begin by asking yourself these questions:

« Has anything changed recently? For example, if the problem
started shortly after updating Mac OS X or installing new software,
that suggests a possible culprit.

Update Got You Down?

If you experience problems after installing an update to Mac
OS X—particularly if you used Software Update—try reinstalling
the update another way. Apple releases most updates in two
forms:

e A standard (or “delta”) form that works only with the previous
version of Mac OS X (updating, say, Mac OS X 10.5.5 to 10.5.6)

e A “combo” form that works with several previous versions (say,
anything from 10.5.0 through 10.5.6)

Software Update always chooses the smallest possible updater,
which usually means the delta updater. Occasionally, however,
delta updaters leave out files that are included in the combo up-
dater. So when in doubt, download the combo updater manually
from http://www.apple.com/support/downloads/ and run it again.
(You won't harm anything by running an updater again.)

« What did you do last? If an application crashed immediately
after you performed some action, what was that action? Recurring
patterns are especially important. If a problem occurs every time
you do something, that something becomes suspicious.

« Did you see any error messages? I can’t tell you how many
times someone has complained to me about a Mac problem, and
then mentioned casually, “Oh yeah, there was some sort of error
message, but I didn’t pay attention to it.” An error message is one
of the best possible clues to a problem’s cause and solution, so you
should make a note of it. The easiest way to do this is to take a
screenshot. Press Command-Shift-3 and Mac OS X takes a picture
of your whole screen, saving it to a file on your Desktop.

You can then refer to that picture, email it to a technical support
person, or print it out if needed. (If your Mac is frozen and the
screen shot procedure doesn’t work, at least write down the error
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message!) By the way, even if no error messages appeared on
screen, one might have been written to a log file. Be sure to take
a look (see Check Log Files).

« What does the Help say? Amazing but true: applications’ online
help (or other included documentation) sometimes actually pro-
vides useful information. Yet users overlook this valuable resource
shockingly often. Check out the commands in the application’s Help
menu or read the help files that came with it.

« Is anything else wrong with your Mac? If your computer
is crashing frequently, and it’s also making a buzzing sound and
billowing smoke, chances are those three symptoms are connected
to each other. Even less serious symptoms, such as unexpected
slowdowns, can be significant.

« Is the problem reproducible? Follow the suggestions in Test for
Reproducibility. See if you can find a series of steps that always
causes the problem you’re seeing, or a series of steps that always
avoids the problem. If you can, you're halfway to a solution.

All right, you’ve asked the right questions and you have some
answers—but what do you do with that information? In some cases
the answers may be obvious. For example, you realize that a problem
occurred right after installing some software, so you uninstall the
software, and the problem goes away.

But in most cases, it’s time to dig deeper. Look for, and test, pro-
cedures suggested by the vendor, a troubleshooting site, or another
resource. Repeat until the problem goes away—or until you've
exhausted all your ideas and it’s time to call a consultant or
repairperson.

Who ya gonna call? The remainder of this section lists resources
you can consult to help you solve your problem, but don’t forget about
your friendly neighborhood Mac geek (see Phone a Friend and Ask at
a User Group). If you happen to have a Mac expert in your quick-dial
list, now’s the time to call.
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ASK THE VENDOR FOR HELP

When it’s clear that a particular piece of hardware or software is
malfunctioning and none of the easy troubleshooting steps helped,
your next step should be to contact that product’s developer. Although
I use the term “vendor” as a generic way to denote a software developer
or a hardware manufacturer, I want to clarify that I'm not talking
about the store where you purchased something. Go right to the
company or individual who made it.

Apple Products

If Apple made the product, begin by visiting http://www.apple.com/
support/. There you can find technical articles, discussion forums, and
links to download software updates.

Searching

If you're unsure where to look for help, type some text into the search
field and press Return. Start by entering your Mac model and a few
words describing the problem (such as MacBook Pro fan noise or iMac
G5 shuts down). If that yields too few results, make your search
broader—for example, by omitting the model name, since a symptom
may apply to many models. If you get too many matches, try narrowing
your search—for example, by including your Mac OS X version number
(MacBook Pro fan noise 10.5.6).

The search results page may have several categories on the left, each
listing a different type of information:

« All Solutions: combines the results from all the categories

« Discussions: posts in Apple’s discussion forum (described just
ahead)

« Downloads: software and firmware updates that may apply to
your problem

« How To: step-by-step procedures for performing common tasks,
including solving some problems

« Manuals: PDF versions of user manuals for Apple products

« Specifications: characteristics of devices matching your search
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« Troubleshooting: articles Apple has written with descriptions
of (and usually solutions for) particular issues

Discussions

Apple provides discussion forums where users can help each other
with their Macintosh problems. You can find the forums at
http://discussions.apple.com/.

Once in the Discussions area, you can click a category to browse a
subject area or use the search field to search all discussions. Generally,
I suggest clicking a category first, and then a forum in that category—
such as “Mac OS X v10.5 Leopard” followed by “Printing”—and then
using the search field to look for articles within just that forum.

I've found lots of useful information in the Apple Discussions site,
but I want to emphasize two things. First, Apple monitors the discus-
sions but does not directly reply to any posts, so don’t assume that
you’ll get help from Apple. Second, to inform Apple of something
behaving incorrectly, you must use a different site, which is available
to members of the Apple Developer Connection. (You can sign up for
a free membership at http://connect.apple.com/.) The Apple Bug
Reporter site is at https://bugreport.apple.com/.

Downloads

Your problem might be solved by updating your Apple software,
although Software Update is usually a better way of finding and
installing the updates appropriate to your system. To look for updates,
go to http://support.apple.com/downloads/. Like the other pages on
Apple’s support site, the Downloads page has its own search box, as
well as a list of recently posted updates. If the software you’re looking
for isn’t on the first page of the list, use the search box.

Live Help
If online help didn’t supply the answer and your Apple product is still
under warranty (or AppleCare):

« Take your Mac to a Genius Bar (see Go to the Source)

« Contact Apple Support. In the United States, you can call them toll-
free at 800-275-2273; in Canada, the number is 800-263-3394.

« Fill out a form with details about your problem and request that
Apple call you immediately, or at a scheduled time in the future; for
details, see http://www.apple.com/support/expert/.
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« For other countries, or for online support options, see
http://www.apple.com/support/contact/.

If your Apple product is no longer covered by warranty, you can pay for
a tech support “incident” ($49); ask for details when you call.

Other Products

For third-party products, start by visiting the vendor’s Web site. To
read FAQs, download software updates, ask questions of other users
on discussion forums, and find out how to contact their support staff
by phone or email, look for a link or button that says “Support” or
“Technical Support.” Be aware that some vendors charge a fee for
technical support, or offer complimentary support only for a limited
time. If you're unable to find contact information, check the packaging
the product came in or its printed documentation.

When you contact the vendor, be prepared to explain in detail the
nature of your problem, what steps you’ve taken to solve it, and any
background information (as covered in Ask the Right Questions) that
might provide clues. Also be sure you know the exact Mac model you're
using, including processor type and amount of RAM, as well as which
version of Mac OS X (and the vendor’s software, if any) you’re running.
If you're unsure, see Get System Information.

CHECK MAC TROUBLESHOOTING SITES

If haven’t found the solutions you need in this book, at a vendor’s Web
site, or on Apple’s Web site, you can avail yourself of numerous other
sites that contain a vast store of information about solving Mac prob-
lems. These sites often include discussion forums where other people
with similar issues can share what they tried and what worked for
them. Among the many Mac troubleshooting sites out there, these are
the ones I've typically found most useful (listed alphabetically):

« MacFixIt (http://www.macfixit.com/): MacFixIt has been around
for many years, and it has an astonishing amount of information
available. Of particular interest are the tutorials on solving common
problems (click the Tutorials link at the top) and the discussion
forums (click the Forums link). The site’s main page describes the
most recently discovered problems and solutions. To search the
archives of less recent posts, you need a subscription to MacFixIt
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Pro ($24.95 per year); you can get a bundle that includes a
VersionTracker Pro subscription (to inform you of all the latest
software updates) for $59.95 per year.

Getting your fix: I love MacFixIt and visit it regularly. But I
want to warn you that I consider many of their recommendations
overcautious—they frequently suggest procedures that, in my
opinion, require an excessive number of steps and time investment
for questionable gain. Also, because the site mentions almost every
odd problem anyone has discovered, it might make you paranoid
that no software update is safe to install, when, in fact, almost no
one may have experienced that particular problem. So: do seek
help at MacFixIt when you need it, but be prepared to take some
of their suggestions with a grain of salt.

MacInTouch (http://www.macintouch.com/): This site provides
Apple-related news and, of interest to people looking for trouble-
shooting help, an ongoing series of reader reports on many Mac
hardware and software products. If you're having trouble with

a system update, a new computer, or a peripheral, scanning these
reports can give you valuable clues. But remember: the fact that
someone reports a problem doesn’t mean you or anyone else will
encounter it, and not every proposed solution will work for you.

MacOSX.com (http://macosx.com/): This free Mac tech support

site provides personalized help from a team of volunteers. You can

also post questions on a public forum and search the results of past
troubleshooting queries.

Mac OS X Hints (http://www.macosxhints.com/): Mac OS X
Hints is run by Macworld Senior Editor Rob Griffiths, with help
from other editors including Take Control author Kirk McElhearn.
Its focus is not on troubleshooting but on getting more out of your
Mac generally; it just so happens that many of the tips provide the
solutions to common problems.

Trouble-Shooting Language Problems
(http://homepage.mac.com/thgewecke/mlingosg.html#trouble):

If your problem involves foreign languages in any way, you may find
the solution in this helpful list by Tom Gewecke, who has contribu-
ted many useful bits of information about Mac OS X’s language
handling to various Take Control titles.
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« The X Lab (http://www.thexlab.com/): This site has numerous
useful FAQs on solving problems with Mac OS X. It also promotes
a gargantuan (over 600-page) ebook called Troubleshooting Mac
OS X, written by “Dr. Smoke” (Gregory E. Swain).

USE YOUR FAVORITE SEARCH ENGINE

If you haven’t found what you’re looking for on any of the top Mac
troubleshooting sites, you may still have success elsewhere on the Web.
Try some searches in Google (or the search engine of your choice).
When you do, keep in mind these tips:

« To narrow searches, be as specific as possible. For example,
searching for GarageBand crash will produce fewer, and more
relevant, results than application quits.

« Tryincluding the word Mac or the phrase "0S X" (in quotation
marks) in your search to exclude some matches that are specific
to Windows or Unix software.

« Include the version number in your search. For example, searching
for kernel panic Mac 10.5.6 might show you more recent and
useful results than kernel panic Mac.

« Ifyou saw an error message on screen or in a log, try searching for
the text of that message.

CONTACT A PROFESSIONAL

I've mentioned this several times already, but it’s worth repeating: lots
of smart, experienced people make their livings solving Mac problems,
and you can contact one if you get stuck. Yes, you’ll have to pay some
money, but if your problem is more than trivial you’ll probably find
that the savings in time (not to mention stress) is worth it.

Assuming you’ve gone through the steps in this section more or less
in order, you should think about visiting a consultant (see Find a
Consultant) or an Apple repair facility (see Go to the Source), keeping
in mind that only the latter can offer low-level hardware repairs on
your Mac or provide service under warranty or AppleCare.
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Learn More

Besides the Web sites listed in Check Mac Troubleshooting Sites, a
few other resources may be of interest.

EBOOKS

« Take Control of Font Problems in Leopard, by Sharon Zardetto
o Take Control of Users & Accounts in Leopard, by Kirk McElhearn
« Take Control of Syncing Data in Leopard, by Michael Cohen

« Troubleshooting Mac OS X by “Dr. Smoke” (Gregory E. Swain) is
a 600-page ebook that goes into great detail about solving a wide
variety of Mac problems.
http://www.thexlab.com/book/troubleshootingmacosx.html

($19.95)

PRINTED BOOKS

« Mac OS X Help Line, Tiger Edition, by Ted Landau and Dan Frakes.
Contains a wealth of troubleshooting and repair information.
http://www.amazon.com/gp/product/0321334299/ ($50 retail;
current Amazon.com price, $34)

« Mac OS X Leopard For Dummies, by Bob LeVitus. Contains a
section on Networking & Troubleshooting.
http://www.amazon.com/gp/product/0470054336/($22 retail;
current Amazon.com price, $15)

« Mac OS X Tiger For Dummies, by Bob LeVitus, is similar to the
previous book in this list, but covers Tiger.
http://www.amazon.com/gp/product/0764576755/($22 retail;
current Amazon.com price, $15)
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About This Book

Thank you for purchasing this Take Control book. We hope you
find it both useful and enjoyable to read. We welcome your
comments at tc-comments@tidbits.com. Keep reading in this
section to learn more about the author, the Take Control series,
and the publisher.

ABOUT THE AUTHOR

Joe Kissell is Senior Editor of TidBITS, a Web site
and email newsletter about the Macintosh and
the Internet, and the author of numerous print
and electronic books about Macintosh software,
including Take Control of Mac OS X Backups
and Take Control of Upgrading to Leopard. He
is also a Senior Contributor to Macworld and was
the winner of a 2009 Neal award for Best How-to
Article. Joe has worked in the Mac software industry since the early
1990s, including positions managing software development for Nisus
Software and Kensington Technology Group.

In his increasingly imaginary spare time, Joe likes to travel, cook,

and practice t’ai chi. He lives in Paris with his wife, Morgen Jahnke.

To contact Joe about this book, send him email at jwk@me.com and
include Take Control of Troubleshooting Your Mac in the subject

of your message so his spam filters won’t intercept it. But please note:
While Joe can answer some questions related to this book, he is unable
to provide free troubleshooting help.
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Featured Titles

Now that you’ve seen this book, you know that Take Control books
have an easy-to-read layout, clickable links if you read online, and
real-world info that puts you in control. Click any book title below
or visit our Web catalog to add to your Take Control collection!

Take Control of Easy Backups in Leopard (Joe Kissell): Devise a rock-
solid backup strategy so you can restore quickly and completely, no
matter what the catastrophe. $10

Take Control of Font Problems in Leopard (Sharon Zardetto): If you're
suffering from font problems in Leopard, help is at hand! $10

Take Control of Mac OS X Backups (Joe Kissell): Set up a rock-solid
backup strategy so that you can restore quickly and completely, no
matter what catastrophe arises. $15

Take Control of Maintaining Your Mac (Joe Kissell): Find a common-
sense approach to avoiding problems and ensuring that your Mac runs
at peak performance. $10

Take Control of Syncing Data in Leopard (Michael Cohen): Is your
data stuck on your Mac? Learn how to sync it with another Mac,
iPhone, iPod, mobile phone, or PDA! $10

Take Control of the Mac Command Line with Terminal (Joe Kissell):
Learn the basics of the Unix command line that underlies Mac OS X,
and get comfortable and confident when working in Terminal. $10

Take Control of Users & Accounts in Leopard (Kirk McElhearn):
Find straightforward explanations of how to create, manage, and
work with—and among—user accounts. $10

Take Control of Your iPhone (Ted Landau): This compendium of
useful information about the iPhone and iPod touch helps you work
more effectively, avoid problems, and fix any existing problems. $15
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